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Аннотация
Книга посвящена обучению работе с популярной программой компьютерного

видеомонтажа Adobe Premiere Pro. Описываются основные приемы работы с программой,
приводятся сведения об управлении проектами и клипами, изучаются методы монтажа
видео и звука, техника создания титров, добавление спецэффектов, а также процесс
окончательного монтирования фильма. На примерах рассматриваются все этапы создания
и обработки фильмов для телевидения, видео и мультимедиа, что делает книгу
привлекательной как для новичков, так и для профессионалов.

Книга для широкого круга пользователей
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Дмитрий Викторович Кирьянов,
Елена Николаевна Кирьянова

Самоучитель Adobe Premiere Pro
 

Введение
 

Перед вами самоучитель, с помощью которого вы сможете самостоятельно освоить
основные возможности приложения Adobe Premiere Pro (в дальнейшем будем называть про-
сто – Premiere).

Изложение материала построено по принципу «от простого – к сложному». Главы,
каждая из которых нацелена на решение определенной задачи, мы назвали уроками, под-
черкивая тем самым, что основное назначение нашей книги – научить читателя работе с
Premiere. При этом мы старались думать о разных пользователях – как начинающих работу с
компьютером вообще и пытающихся освоить Premiere «с нуля», так и продвинутых, знако-
мых с приложениями Adobe Photoshop и Premiere, а также с предыдущими версиями Adobe
Premiere.

Хотим сразу оговориться, что мы старались максимально упростить восприятие мате-
риала. Для этого мы сделали акцент на частом использовании поясняющих рисунков и
экранных форм, на которых, при помощи указателя мыши, подчеркивали смысл рисунка.

Эта книга является одним из двух (равноценных) томов самоучителя, посвященных
двум наиболее популярным приложениям для компьютерного видеомонтажа – Adobe After
Effects и Premiere. Два самоучителя, хотя и имеют одинаковый стиль подачи материала, абсо-
лютно независимы (в том смысле, что для чтения одного вовсе не требуется знакомство с
другим). Тем не менее, по ходу изложения мы иногда вспоминаем о второй из программ,
поскольку по замыслу разработчиков они дополняют друг друга, и большая часть пользова-
телей работает с обоими приложениями.

В каждом из уроков книги решается конкретная проблема видеомонтажа в приложении
Premiere. Таким образом, мы постарались охватить все основные приемы и возможности
данной программы.

Надеемся, что наша книга поможет вам быстро и качественно овладеть всеми тонко-
стями компьютерной обработки видео при помощи замечательного пакета Premiere.

Авторы
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Урок 1

Общие сведения о цифровом видео
 

Первый урок посвящен знакомству с принципами компьютерного видеомонтажа и гра-
фики и адресован, в первую очередь, новичкам в области цифрового видео. В нем в сжатой
форме объясняются принципы хранения и обработки видео – и звукозаписей на компьютере,
описываются основные параметры видеофайлов (размер, частота кадров и т. п.).

□ Чего мы хотим:
• понять основные принципы хранения и обработки цифрового видео и звука;
• изучить наиболее важные свойства медиа – файлов.

Уже довольно давно персональные компьютеры используются в качестве средства вос-
произведения и редактирования цифрового видео. Технология, позволяющая отображать на
экране монитора видео и воспроизводить с помощью акустических систем звук, получила
название мультимедиа. С точки зрения хранения мультимедийной информации на компью-
тере (вообще говоря, любые данные представляются на нем в виде файлов определенного
типа), можно выделить несколько основных типов файлов:

□ audio (звуковые, или аудио) – только звук, который проигрывается через акустиче-
скую систему (например, файлы с расширениями wav, mp3, aiff и т. п.);

□ video (анимационные, или видео) – видео может быть беззвучным, а может и звуко-
вым, т. е. сопровождаться синхронным звуком (файлы с расширением avi, mov и т. п.);

□ image (рисунки, или статические изображения) – обычные картинки (несколько
условный тип, однако нам будет удобно говорить о нем в книге как о полноценной разно-
видности мультимедиа). Это файлы с расширениями gif, jpeg, tiff, bmp и т. п.

Общее название перечисленных типов файлов – это мультимедиа-, или просто медиа
– файлы (рис. 1.1). Коротко остановимся на принципах хранения информации в медиа –
файлах, начав с самого простого их типа – рисунков (статических изображений).
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Рис. 1.1. Типы мультимедиа
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1.1. Статические изображения

 
Вероятно, сегодня практически каждый пользователь представляет себе основной

принцип хранения и отображения графической информации на компьютере. Тем не менее,
скажем об этом несколько слов, чтобы последующие сведения о цифровом видео (которое
представляет собой сменяющую друг друга последовательность изображений) были для нас
понятнее.

 
1.1.1. Разрешение

 
На первый взгляд, качественный рисунок, будучи отображенным на экране хорошего

монитора, мало чем отличается от обычной фотографии. Однако на уровне представления
изображения это отличие просто огромно. В то время, как фотографический снимок созда-
ется на молекулярном уровне (т. е. составляющие его элементы принципиально не раз-
личимы человеческим зрением независимо от увеличения), рисунки на экране монитора
(и, подчеркнем, в памяти компьютера) формируются благодаря пикселам — элементарным
составляющим изображения (чаще всего) прямоугольной формы. Каждый пиксел имеет
свой определенный цвет, однако из – за их малого размера отдельные пикселы (почти или
вовсе) неразличимы глазом, и у человека, рассматривающего картинку на экране монитора,
их скопление создает иллюзию непрерывного изображения (рис. 1.2).

Примечание
Изображения на экранах компьютеров формируются при помощи

пикселов квадратной формы. В отличие от компьютеров, во многих
стандартах телевидения используются не квадратные, а прямоугольные
пикселы. Параметром, характеризующим отношение размеров пикселов,
выступает отношение их горизонтального и вертикального размеров, или
пропорции пиксела (pixel aspect ratio).

Рис. 1.2. Изображения на компьютере формируются благодаря пикселам

Каждый пиксел (кстати, слово pixel образовано от первых двух букв английских слов
picture element) представляет информацию о некоторой «средней» интенсивности и цвете
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соответствующей области изображения. Общее число пикселов, представляющих рисунок,
определяет его разрешение. Чем больше пикселов создают изображение, тем естествен-
нее оно воспринимается человеческим глазом, и тем, как говорят, выше его разрешение
(рис. 1.3). Таким образом, пределом «качества» компьютерного рисунка является размер
формирующих его пикселов. Более мелкие, чем пикселы, детали компьютерного рисунка
совершенно теряются и, в принципе, невосстановимы. Если рассматривать такой рисунок в
увеличительное стекло, то, по мере увеличения, мы увидим только расплывающееся скоп-
ление пикселов (см. рис. 1.2), а не мелкие детали, как это было бы в случае качественного
фотоснимка.

Здесь стоит оговориться, что, во – первых, мы имеем в виду традиционную (аналого-
вую, а не цифровую) фотографию (т. к. принцип цифровой фотографии как раз тот же самый,
что и обсуждаемый принцип формирования изображения из пикселов), а во – вторых, даже
для нее, говоря о качестве изображения, всегда следует помнить о самой технологии фото-
графии. Ведь изображение на фотопленке появляется благодаря прохождению света через
объектив фотокамеры, и его качество (в частности, четкость и различение мелких деталей)
напрямую зависит от качества оптики. Поэтому, строго говоря, «бесконечная» четкость тра-
диционного фотографического снимка, о которой мы говорили, является некоторым преуве-
личением.

Примечание
На самом деле, современные цифровые фотокамеры позволяют

зафиксировать изображение, разрешение которого практически не уступает
аналоговому (в том смысле, что сейчас возможно оцифровать такое
количество пикселов, которое будет «перекрывать» границы разрешения
самой оптики). Однако для предмета нашей книги этот факт не играет
важной роли, т. к. в настоящее время цифровое видео в подавляющем
большинстве случаев передается именно с невысоким разрешением
(относительно малым общим числом пикселов), и принимать во внимание
такой параметр, как разрешение, просто необходимо.
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Рис. 1.3. Общее число пикселов (разрешение) определяет качество изображения

Итак, немного упрощая, чтобы представить рисунок в цифровом виде, необходимо
покрыть его прямоугольной сеткой размера MxN (М точек по горизонтали и N по верти-
кали). Это сочетание чисел MxN (например, 320x240, 800x600 и т. д.) и называют разреше-
нием (resolution) изображения, или размером кадра (frame size). Затем следует усреднить
данные о структуре изображения в пределах каждого пиксела и записать соответствующую
информацию о каждом из MxN пикселов изображения в графический файл. Для цветного
изображения это будет информация о конкретном цвете каждого пиксела (о компьютерном
представлении цвета написано чуть ниже в этом разделе), а для черно – белых изображений
– это информация об интенсивности черного цвета. Чтобы объяснить некоторые важные
параметры компьютерного представления изображений, остановимся далее чуть подробнее
на их последнем типе – рисунках, выполненных в оттенках серого цвета (grayscale), т. е.
в градации от белого до черного.

 
1.1.2. Глубина пиксела

 
Поскольку компьютер оперирует исключительно цифрами, то для описания интен-

сивности цвета отдельного пиксела он применяет определенное числовое значение, кото-
рое является целым числом, т. е. – 0, 1, 2 и т. д. К примеру, чисто белый цвет в черно –
белых рисунках будет описываться нулевой интенсивностью, чисто черный – некоторым
максимальным числом, а серые цвета – промежуточными значениями (в зависимости от их
оттенка). Важным параметром, влияющим на качество представления изображения, явля-
ется именно это максимальное значение интенсивности, которое (за вычетом единицы)
называется глубиной пиксела (pixel depth).

Если глубина пиксела равна, к примеру – 128, то это означает, что (кроме белого и чер-
ного цветов, интенсивность которых, по определению, равна О и 127 соответственно) воз-
можно представить на экране компьютера лишь 128 – 2 = 126 оттенков серого цвета (рис. 1.4,
а). Промежуточные цвета отобразить будет невозможно, и (если таковые присутствовали в
исходном изображении до оцифровки) они будут заменены наиболее близким оттенком из
этих 126 градаций. В то же время для изображений с глубиной пиксела равной 256, возможно
отобразить в два раза больше оттенков, и поэтому такое изображение будет, скорее всего,
существенно более естественным.

Минимально возможная глубина пиксела, равная 2, позволяет представить лишь два
цвета – черный и белый (рис. 1.4, б) – и подходит для графического хранения черно – белых
документов с линейной графикой (line art).

Примечание
В качестве градаций глубины пиксела выбираются числа 2, 128, 256

и т. д., т. к. все они являются степенями цифры 2, обеспечивая наиболее
эффективное хранение данных на компьютере (оперирующем изначально
числами в двоичном представлении). Напомним читателю, что один байт
информации как раз эквивалентен хранению одного из чисел диапазона 0…
255.
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Рис. 1.4. Черно – белые изображения с одинаковым разрешением, но разной глубиной
пикселов

 
1.1.3. Качество (компрессия)

 
Хранение всей информации о том или ином изображении (т. е. о цвете каждого его пик-

села) зачастую или невозможно, или неэффективно. Например, рисунок размером 800x600
пикселов требует записи информации о 800x600 = 480 000 пикселах. Если использовать глу-
бину пиксела, равную 256 (т. е. кодировать каждый пиксел одним байтом), то размер файла,
хранящего изображение (в оттенках серого цвета), будет равен почти половине мегабайта.

Примечание
Несколько забегая вперед отметим, что для хранения такого же

цветного изображения потребуется файл уже в три раза большего размера
(почти 1.5 Мбайт), а для хранения одной секунды цветного видео с кадром
такого качества и типичной частотой кадров 24 кадра/с целых 40 Мбайт!
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Чтобы уменьшить размеры файлов, хранящих изображения, применяются специаль-
ные программы, называемые компрессорами, или, по – другому, кодеками (codec – от англ.
compressor/decompressor). Процедуру уменьшения размера медиа – файла называют ком-
прессией или сжатием. Как правило, при сжатии некоторая часть информации о рисунке
теряется, и его качество соответственно понижается. Многие программы – компрессоры поз-
воляют регулировать степень ухудшения рисунков путем варьирования параметра, называ-
емого качеством сжатия, которое обычно измеряется в процентах. Очевидно, что чем силь-
нее сжато изображение (т. е. чем меньше получившийся медиа – файл), тем хуже будет его
качество (рис. 1.5).

Рис. 1.5. Два изображения с разным качеством компрессии

Все сказанное о рисунках в полной мере (и даже сильнее, т. к. при компрессии
может учитываться дополнительная информация о последовательностях кадров) относится
и к видеофайлам. Как правило, эффективность сжатия существенно зависит от структуры
самого изображения, и правильный подбор кодека зачастую позволяет достичь просто фан-
тастических успехов в улучшении качества изображений. Очевидно, что следует выбирать
такие кодеки и так регулировать их параметры, чтобы, с одной стороны, обеспечить хорошее
качество изображения, а с другой – скорость расчетов и приемлемый физический размер
медиа – файла. Однако, зачастую, идеальный подбор кодека является «почти искусством» и
под силу только очень опытным пользователям.

 
1.1.4. Цвет

 
Ограничимся самыми общими упоминаниями о технологии компьютерного отобра-

жения цветных изображений. Как известно, человеческий глаз устроен таким образом, что
способен раздельно воспринимать три цвета, называемых основными: красный, зеленый и
синий. Какой – либо предмет, имеющий определенный цвет, воспринимается нашим зре-
нием как определенная комбинация этих основных цветов. Например, белый цвет ассоции-
руется нами как смесь всех трех основных цветов в максимальной равной пропорции, чер-
ный – как комбинация нулевых интенсивностей основных цветов, чисто синий цвет – как
комбинация максимальной пропорции синего и нулевой – красного и зеленого, и т. д.

Именно на этом принципе и построено компьютерное представление цвета. Каждый
пиксел цветного изображения кодируется тремя числами – сочетанием трех основных цве-
тов: красного, зеленого и синего. Такую систему кодирования цвета называют моделью RGB
(от англ. Red, Green, Blue — красный, зеленый, синий). Как правило, каждый цвет кодиру-
ется одним байтом информации, т. е. пропорции цветов представляются числами от 0 до 255.
Разумеется, такая система передачи цвета является дискретной, т. е. не каждый имеющийся
в природе цвет (число оттенков которого бесконечно) можно представить на компьютере.
В этом смысле цифровое представление цвета имеет те же плюсы и минусы, что и рассмот-
ренная нами выше передача интенсивности черно – белых изображений.
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Примечание
Некоторые рисунки хранят информацию о цвете в других системах,

например, CMYK – модели (голубой, пурпурный, желтый и черный), часто
применяемой в бумажной полиграфии. Однако для представления на экране
монитора компьютера сочетание этих цветов все равно пересчитывается в
комбинацию основных цветов RGB.

Говоря о технологии передачи цвета на компьютере, нельзя не сказать о том, что она
тесно связана с проблемой компрессии изображений. Легко можно сосчитать, что если каж-
дый из основных цветов кодировать при помощи одного байта, то общее число возмож-
ных цветов составит более 16 миллионов. Кодировать каждый пиксел изображения с уче-
том такого большого количества цветов зачастую представляется расточительным. Поэтому
многие кодеки используют несложный трюк, позволяющий значительно уменьшить раз-
мер графического файла. Они изначально, исходя из предварительного анализа исходного
рисунка, готовят набор характерных именно для него цветов (например, 256 цветов), назы-
ваемый цветовой палитрой (color palette). Информация об этих цветах записывается в опре-
деленном виде в графический файл, а потом уже изображение «перерисовывается» коде-
ком исключительно при помощи цветов из созданной палитры. Разумеется, некоторые цвета
исходного рисунка при таком способе компрессии приходится заменять наиболее близкими
цветами из палитры, что ухудшает качество изображения, но позволяет существенно сокра-
тить физический размер графического файла. При работе с цветными изображениями на
компьютере, важно постоянно помнить о принципе использования цветовых палитр, и в
случае необходимости (для достижения лучшего качества цветопередачи или, напротив, в
целях минимизации размера файла) корректировать параметры кодека.
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1.2. Видео

 
Все, сказанное выше по отношению к статическим изображениям, относится и к видео.

Надо лишь помнить о том, что впечатление просмотра видео на компьютере создается бла-
годаря быстрому чередованию отдельных статических изображений, называемых кадрами
(frames). Количество кадров, демонстрируемых в течение одной секунды, называется часто-
той кадров (frame rate). Психология человеческого восприятия такова, что при чередовании
с частотой более 20-ти кадров в секунду они не воспринимаются как отдельные изображе-
ния, а полностью создают иллюзию просмотра динамической картины (рис. 1.6).

Рис. 1.6. Иллюзия просмотра видеофильма основана на принципе быстрого чередова-
ния кадров

Принцип покадрового видео, как вы знаете, лежит в основе традиционного (аналого-
вого) кино и телевидения. Отличие компьютерного представления видео проявляется лишь
на изложенных нами ранее характеристиках отдельных кадров видео как компьютерных
изображений. Сведем все то, о чем мы уже рассказали, и то, о чем только собираемся рас-
сказать, в одну таблицу (табл. 1.1) (не касаясь пока звука, рассмотренного в следующем раз-
деле).

Внимание
Заметим, что термином «цифровое видео» здесь и далее мы

обозначаем не только видео, которое воспроизводится на мониторе
компьютера, но и современные «некомпьютерные» технологии (цифровые
видеомагнитофоны, видеокамеры и т. п.).

Таблица 1.1. Цифровое и аналоговое видео
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Исторически сложилось, что разные стандарты кино и ТВ поддерживают различную
частоту кадров. Приведем характеристики некоторых из них:

□ 24 (кадра/с) – используется для создания кинофильмов на кинопленках (классиче-
ский кинематограф);

□ 25 (кадров/с) – стандарт PAL/SECAM, европейский стандарт телевидения;
□ 29.97 (кадров/с) – стандарт частоты кадров для NTSC (североамериканского стан-

дарта телевидения);
□ 30 (кадров/с) – режим, довольно часто применяемый для создания компьютерных

мультимедийных продуктов.
При работе с цифровым видео большое значение имеет договоренность о нумерации

отдельных кадров. Способ и формат расстановки числовых меток, связанных с каждым кад-
ром, называется тайм – кодом (timecode) кадра. Чаще всего используется отображение тайм
– кода в стандарте NTSC, определяющий нумерацию кадров в пределах каждой секунды
фильма, т. е. в виде час: минута: секунда: кадр. Например, тайм – код 01:37:10:21 означает
21-й кадр 10-й секунды 37-й минуты 1-го часа от начала фильма. Однако наряду с таким
представлением иногда применяются и альтернативные варианты нумерации кадров (напри-
мер, сквозная нумерация кадров по порядку от начала до конца, без ссылки на время, т. е.
0, 1, 2, 100 000, 100 001, 100 002 и т. д.).

Рис. 1.7. Качество цифрового видео зависит от разрешения и других параметров
отдельных кадров
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Подытожим основной принцип компьютерного представления видео: эффект воспри-
ятия человеческим зрением динамической картины создается благодаря последовательной
демонстрации (с достаточной частотой) отдельных кадров (см. рис. 1.6). При этом каждый
кадр является стандартным компьютерным рисунком, обладая всеми его характерными каче-
ствами (рис. 1.7), а для уменьшения размеров видеофайлов часто применяются специальные
программы, называемые кодеками, большинство из которых используют принцип схожести
последовательных кадров друг с другом.
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1.3. Звук

 
Посвятим данный раздел объяснению основных моментов возникновения, распро-

странения и восприятия человеком звука, а также главным параметрам, связанным с пред-
ставлением цифровой аудиоинформации.

 
1.3.1. Что такое звук?

 
С физической точки зрения, звук, в широком смысле этого слова, представляет собой

колебания частиц окружающей среды (воздуха), передающиеся от точки к точке. Процесс
распространения звука (в несколько упрощенном виде) происходит следующим образом.
Некоторый источник (например, струна музыкального инструмента, мембрана динамика
акустической системы или т. п.) совершает быстрые колебания с определенной частотой и
амплитудой. Частотой называется количество повторений цикла колебаний в секунду, а
амплитудой — максимальное отклонение колеблющегося тела от среднего состояния, изме-
ряемое, например, в миллиметрах.

В результате взаимодействия источника звука с окружающим воздухом частицы воз-
духа начинают сжиматься и расширяться в такт (или «почти в такт») с движениями источ-
ника звука. Затем, в силу свойств воздуха как текучей среды, происходит передача колеба-
ний от одних частиц воздуха другим (рис. 1.8).

Рис. 1.8. К объяснению распространения звуковых волн

В результате колебания передаются по воздуху на расстояние, т. е. в воздухе распро-
страняется звуковая или акустическая волна, или, попросту, звук. Звук, достигая уха чело-
века, в свою очередь, возбуждает колебания его чувствительных участков, которые вос-
принимаются нами в виде речи, музыки, шума и т. д. (в зависимости от свойств звука,
продиктованных характером его источника).
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Рис. 1.9. График динамики интенсивности звуковых волн является их исчерпывающей
характеристикой

Чем больше амплитуда колебаний источника, тем больше интенсивность возбуждае-
мых им звуковых волн (т. е. значение локальных сжатий и разрежений воздуха, происходя-
щих в звуковой волне), следовательно, тем громче звук, воспринимаемый нашими органами
слуха. Интенсивность звука в технике принято измерять в децибелах, сокращенно дБ (dB).
Зависимость интенсивности звука от времени (рис. 1.9) является исчерпывающей информа-
ции об этом звуке.

Частота звука, как уже было сказано, измеряется в единицах в секунду – в гер-
цах, сокращенно Гц (Hz). Частота определяет высоту тона, воспринимаемую нашим ухом.
Малые, или низкие, частоты (порядка сотен герц) связаны в нашем сознании с глухими
басами, а большие, или высокие, частоты (десятки тысяч герц) – с пронзительным свистом.
Таким образом, человеческий слух способен воспринимать звук от сотен до десятков тысяч
герц, а более низкие и более высокие, чем порог слышимости, частоты называются соответ-
ственно инфразвуком и ультразвуком.

Примечание
В отношении звуковых волн часто используются производные

единицы частоты– килогерц (кГц), равная 1000 Гц и, реже, мегагерц
(МГц), равная 10е Гц. Чтобы не запутаться, имейте в виду, что мегагерцы,
описывающие быстродействие компьютеров, никакого отношения к звуку не
имеют (они определяют частоту электрических колебаний в процессоре).

На самом деле, подавляющее большинство знакомых нам звуков не является колеба-
ниями определенной частоты, а представляют собой смесь различных частот, или спектр.
Однако некоторые частоты в спектре, чаще всего, доминируют, определяя наше общее впе-
чатление от звука, который мы слышим (об этом можно судить и по приведенному на рис. 1.9
графику интенсивности звука).

Итак, звук является акустическими волнами, передаваемыми в воздухе, и его основ-
ными характеристиками являются частота и интенсивность, а полноценной записью звуко-
вых волн может быть признан временной график интенсивности.

 
1.3.2. Частота дискретизации

 
Очевидно, что для записи звука на компьютере требуется представить в цифровом

виде график зависимости интенсивности звука от времени. Для этого достаточно записать в
аудиофайл последовательные значения интенсивности звука, измеренные через определен-
ные (чаще всего, равные) промежутки времени (рис. 1.10). Чем чаще будет произведена такая
запись, тем большая информация о звуке будет сохранена, и, соответственно, тем лучше и
естественнее будет передан при помощи компьютера звук, однако тем большим по размеру
получится звуковой файл.
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Рис. 1.10. Цифровое представление звука связано с дискретизацией временной зави-
симости интенсивности

Итак, частотой дискретизации (rate) называется частота записи графика интенсивно-
сти, при помощи которой звук представляется в цифровом виде. Например, частота 5000
Гц означает, что каждая запись звука производится через временные интервалы 1 / 5000 =
0.0002 с.

Очевидно, что частота дискретизации для звуковых файлов имеет то же значение, что
и разрешение для видеофайлов.

 
1.3.3. Глубина кодировки звука (формат)

 
Подобно действию рассмотренного нами ранее для видеофайлов параметра глубины

пиксела, в аудиофайлах каждое текущее значение интенсивности звука может быть коди-
ровано с использованием различного числа возможных градаций. Таким образом, глубина
кодировки звука определяет количество битов информации, кодирующих интенсивность
звуковой волны в каждый момент времени. Очевидно, что, чем больше количество записы-
ваемых в звуковой файл битов, тем с лучшей точностью и разрешением по интенсивности
прописывается в цифровом виде звук, тем лучше и естественнее качество звучания.

Поясним сказанное на простом примере (рис. 1.11). Рассмотрим малый интервал вре-
мени, для которого имеется несколько измеренных значений интенсивности (для определен-
ных отсчетов времени с равными промежутками). Эти значения интенсивности обозначены
на рисунке крестиками. Если использовать высокую глубину кодировки, то при помощи
достаточного числа бит информации можно записать в звуковой файл данные значения
интенсивности с большой точностью (столбики на рис. 1.11, б). Однако, в целях уменьше-
ния размера файла, глубина кодировки может быть уменьшена. Это означает, что имеюще-
еся в распоряжении компьютера число бит информации будет недостаточным, чтобы запи-
сать точные значения интенсивности, а вместо них в файл будут записаны наиболее близкие
допустимые значения (столбики на рис. 1.11, а). Разумеется, из – за отличий в исходном
звуковом сигнале и записанной в аудиофайл информации качество воспроизведения звука
во втором случае будет гораздо худшим. Подчеркнем, что в обоих случаях использовалось
одинаковое значение частоты дискретизации.
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Рис. 1.11. К объяснению смысла параметра глубины кодировки звука (глубина коди-
ровки левого графика меньше)

 
1.3.4. Моно и стерео

 
Упомянем о хорошо известном всем стереофоническом эффекте, позволяющем син-

хронно воспроизводить из двух различных динамиков различный звук. Как известно, фор-
мат Моно связан с записью в аудиофайл одной звуковой дорожки, а формат Стерео – двух
(в последнем случае размер файла по сравнению с монофоническим удваивается благодаря
записи в один аудиофайл двух зависимостей интенсивности звука от времени – пример пока-
зан на рис. 1.12).
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Рис. 1.12. Формат Стерео связан с синхронной записью в один файл двух звуковых
каналов

В последнее время все более широкую популярность приобретают многоканальные
стереофонические эффекты (предусматривающие воспроизведение не двух, а большего
числа звуковых каналов, что, естественно, в соответствующее число раз увеличивает раз-
меры файлов). В этом случае важную роль приобретает схема расстановки динамиков
относительно слушателя, поскольку многоканальная стереофония позволяет создать полно-
ценный «эффект присутствия» (хорошим примером является стандарт Dolby Surround, при-
меняемый в современном кинематографе).

 
1.3.5. Качество (компрессия)

 
Чем больше частота дискретизации и глубина кодировки звука, тем качественнее

результат воспроизведения аудиофайла, но и, к сожалению, тем больше его физический раз-
мер. Для уменьшения размеров звуковых файлов применяются специальные программы,
называемые (как и в случае видеофайлов) компрессорами, или кодеками (codec). Процедуру
уменьшения размера звукового файла также называют компрессией, или аудиосжатием.

В последнее время (в основном, благодаря широко известному формату МРЗ) появи-
лись новые, попросту фантастические, возможности чрезвычайно эффективно сжимать зву-
ковые файлы, оставляя их качество очень хорошим. Эти технологии постоянно совершен-
ствуются, с каждым годом открывая для пользователей все более широкие возможности.
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Урок 2

Интерфейс Premiere
 

Начнем наше первое знакомство с приложением Premiere с описания первых шагов
работы с этой программой и краткого объяснения особенностей ее интерфейса.

□ Чего мы хотим:
• понять базовые принципы монтажа в Premiere и выяснить назначение трех основных

окон Premiere – Project (Проект), Monitor (Монитор) и Timeline (Монтаж);
• познакомиться с некоторыми вспомогательными элементами интерфейса Premiere;
• создать простой фильм, состоящий из видеоряда внешнего файла;
• создать другой фильм, который будет содержать первый фильм в качестве составной

части.
□ Нам потребуется:
• сама программа Premiere, которая должна быть установлена на вашем компьютере;
• любой видеофайл.
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2.1. Начало работы в программе Premiere

 
Начнем работу со знакомства с интерфейсом программы.

 
2.1.1. Запуск

 
После завершения установки программы на вашем компьютере нажмите кнопку Start

(Пуск) и затем выберите в главном меню ОС Windows пункт Adobe Premiere Pro.
Примечание
Впоследствии вы сможете запускать приложение Premiere двойным

щелчком на файлах проектов, которые вы до этого сохранили. Эти файлы,
начиная с новой версии Premiere Pro, имеют расширение prproj (например,
start.prproj). Прежним версиям (вплоть до Premiere 6.5) соответствовали
файлы проектов с расширением аер (например, start.aep). Их также можно
редактировать в среде Premiere Pro.

Рис. 2.1. Начнем работу в Premiere с создания нового проекта

После загрузки на экране возникнет окно приложения Premiere, на фоне которого
появится диалоговое окно с приглашением Welcome to Adobe Premiere Pro (Добро пожа-
ловать в Adobe Premiere Pro). В данном окне нажатием соответствующей кнопки можно
либо начать монтаж нового проекта – New Project (Создать проект), либо открыть суще-
ствующий файл проекта – Open Project (Открыть проект), либо обратиться к справочной
системе – Help (Помощь) (рис. 2.1). Если вы выберете опцию создания нового проекта, то
перед загрузкой содержимого основного окна Premiere вам будет предложено определить
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его установки, т. е. основные параметры, определяющие настройки окон, в которых будет
происходить редактирование проекта (размер изображения фильма, частота кадров, способ
нумерации кадров и т. п.).

Мы начнем работу с создания нового проекта и разберемся с особенностями интер-
фейса программы.

1. Нажмите кнопку New Project (Создать проект) в диалоговом окне с приглашением.

Рис. 2.2. Выберите в качестве установок проекта один из наборов установок DV – PAL

2. Выберите в левом списке Available Presets (Доступные предустановки) открывше-
гося диалогового окна New Project (Создание проекта) пункт DV – PAL – Standart 32kHz
(Цифровое видео – стандарт PAL – Стандартный звук 32 кГц) (рис. 2.2). Это будет означать,
что для дальнейшей работы мы выбрали набор установок, составленный разработчиками
Premiere, предназначенный для создания фильма в формате PAL (европейском стандарте
телевидения). После того как вы выберете одну из предустановок, параметры, составляю-
щие ее набор, отобразятся на панелях Description (Описание) справа.

3. Введите в нижнее текстовое поле Name (Название) название проекта, например,
start. В поле Location (Расположение) над ним задайте путь к папке на вашем компьютере,
куда будет сохранен файл с проектом.

4. Нажмите в диалоговом окне New Project (Создание проекта) кнопку ОК
Внимание
Предустановки DV – PAL или DV – NSTC предназначены для

подготовки фильмов в стандарте DV (Digital Video – цифровое видео)
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и подразумевают, чаще всего, что созданный фильм будет затем
экспортироваться либо на DVD – диск, либо на внешнее DV – устройство,
подключенное к компьютеру. Если вы собираетесь разрабатывать фильмы
для других целей, обратитесь к уроку, посвященному установкам (см. урок
4).

 
2.1.2. Окна и закладки

 
После определения установок в основное окно Premiere загрузится несколько дочер-

них окон, каждое из которых предназначено для проведения определенных операций по мон-
тажу фильма (рис. 2.3). Самыми важными являются три окна:

□ Project (Проект) – для управления составом проекта (исходными клипами, импор-
тированными из внешних файлов, и фильмами, которые вы редактируете);

□ Timeline (Монтаж, или Монтажный стол) – для монтажа фильма при помощи схема-
тического расположения вдоль временной шкалы составляющих его клипов клипов, симво-
лически представленных прямоугольными блоками;

□ Monitor (Монитор) – для просмотра изображения кадров исходных клипов и филь-
мов, а также для визуального монтажа.

Окно Project (Проект) является библиотекой фильмов и клипов, а два других окна
служат, собственно, для управления процессом монтажа. Все три окна имеют (в их верх-
ней части) закладки, позволяющие отобразить информацию, относящуюся к определенному
объекту. В частности, закладки окон Timeline (Монтаж) и Monitor (Монитор) являются ни
чем иным, как идентификатором фильма, открытого в данный момент. Новый проект откры-
вается в Premiere с автоматически добавленным в него фильмом, который, как видно из
рис. 2.3, называется по умолчанию Sequence 01. Строка с таким названием находится в окне
Project (Проект), а закладки открыты в окнах Monitor (Монитор) и Timeline (Монтаж), что
говорит о приложении действий пользователя к монтажу именно этого (активного) фильма.
Если бы в проекте были созданы и открыты в окнах Monitor (Монитор) и Timeline (Монтаж)
другие фильмы, то активный фильм можно было бы определить по выделенной закладке –
на рис. 2.4 активным является фильм Sequence 2.
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Рис. 2.3. Вид окна Premiere после первого запуска
Примечание 1
Несколько забегая вперед, скажем, что термином клип (clip) мы

называем содержимое исходных медиа – файлов (видео, звуковых или
графических), а термином фильм (sequence) – предмет вашей работы в
Premiere, т. е. финальное видео, которое вы монтируете из клипов.

Примечание 2
Как вы уже догадались, в Premiere Pro теперь имеется возможность

одновременно редактировать несколько фильмов (чего были лишены
прежние версии программы). Каждый фильм редактируется независимо в
окнах Timeline (Монтаж) и Monitor (Монитор), при этом одни фильмы
могут быть вставлены в виде составной части в другие. В оригинале
разработчики Premiere используют термин sequence (последовательность,
англ.), подчеркивая определение фильма как последовательности исходных
клипов.
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Рис. 2.4. В окне Timeline открыто три фильма (активным является фильм Sequence 02)

Помимо трех основных окон, которые используются при монтаже фильма, на экран
выводятся еще несколько окон с облегченным интерфейсом, называющихся палитрами (см.
рис. 2.3). Они служат для вспомогательных целей и применяются, главным образом, для
облегчения процесса монтажа и вывода дополнительной информации:

□ History (Журнал) – палитра, служащая для просмотра и, возможно, отмены послед-
них действий по редактированию фильма;

□ Info (Информация) – палитра, отображающая вспомогательную контекстно – зави-
симую информацию (почти всегда относящуюся к выделенному в других окнах объекту).

Принцип монтажа в Premiere основан на выполнении над исходными клипами дей-
ствий определенного типа, для чего следует использовать соответствующий инструмент.
В каждый момент времени может быть активным только один инструмент, а выбрать его
можно в специальной палитре – Tools (Инструментарий).

Кроме описанных средств интерфейса, Premiere имеет дополнительные окна и
палитры, которые либо облегчают действия по монтажу фильма (например, дублируя функ-
ции некоторых основных окон), либо позволяют управлять дополнительными возможно-
стями (например, создавать титры или применять спецэффекты).

К дополнительным окнам относятся:
□ Effects (Эффекты) – для назначения того или иного эффекта клипам, включая

эффекты перехода;
□ Effect Controls (Управление эффектом) – для регулировки назначенного эффекта и

задания его параметров;
□ Title Designer (Дизайнер титров) – для создания и редактирования клипов с титрами;
□ Audio Mixer (Аудиомикшер) – для традиционного микширования звуковых клипов.

Примечание
Если вы не видите при повторном запуске Premiere каких – либо

из перечисленных окон, то, вероятно, вы их закрыли в прошлых сеансах
работы. Для того чтобы вызвать их вновь на экран, воспользуйтесь одним из
пунктов меню Window (Окно).
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Рис. 2.5. Вызов на экран скрытых окон производится при помощи пункта меню
Window

Все окна допускается перемещать по экрану (перетаскивая за заголовок окна) и изме-
нять их размер (перетаскивая нужную границу окна), настраивая тем самым рабочую
область в виде, наиболее удобном для конкретного пользователя. Одно из окон всегда явля-
ется активным, о чем говорит яркий цвет его заголовка. На рис. 2.3 активным является окно
Project (Проект). Все действия пользователя в Premiere (включая применение горячих кла-
виш) касаются активного окна. Для того чтобы сделать то или иное окно активным, доста-
точно щелкнуть мышью в его пределах.

Внимание
Следите за тем, какое из окон является активным в каждый момент

времени. От этого, в частности, решающим образом зависят действия
Premiere в ответ на нажатие вами клавиш на клавиатуре, выбор пунктов меню
и т. п.

Любое окно, как и в большинстве приложений ОС Windows, можно закрыть стандарт-
ной кнопкой управления окном Close (Закрыть) (рис. 2.6), располагающейся в правом верх-
нем углу заголовка окна. Для повторного вызова окна на экран следует воспользоваться
командой меню Window (Окно).

Рис. 2.6. Кнопки управления окном

Новая версия программы Premiere характеризуется возможностью одновременного
редактирования нескольких фильмов, организованного при помощи закладок окон. Закрыть
любую из закладок окна можно при помощи специально предусмотренной кнопки (рис. 2.7).
О том, какими дополнительными приемами можно пользоваться при работе с несколькими
фильмами, будет сказано ниже (см. разд. 2.3).
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Рис. 2.7. Закрыть одну из закладок окна можно при помощи кнопки закрытия

Следует помнить о том, что закрытие окна Project (Проект) отличается от закрытия
всех остальных окон. Окно Project (Проект) не скрывается временно с экрана, а полностью
закрывает текущий проект, выгружая и все остальные окна. Для возвращения к редактиро-
ванию проекта вам следует вновь открыть его либо создать новый проект, пользуясь диа-
логовым окном – приглашением (см. рис. 2.1). Кнопка управления окном Hide (Свернуть)
сворачивает окно до минимального размера (части заголовка) и помещает его в таком виде
в левый нижний угол рабочей области. Вновь развернуть свернутое окно можно повторным
нажатием той же кнопки.

Примечание
В отличие от других приложений Windows, в Adobe Premiere окна

нельзя развернуть во весь экран родительского окна, т. к. при монтаже
существенное значение имеет одновременное использование нескольких
окон, и сразу несколько окон должны всегда находиться на экране.

 
2.1.3. Элементы управления

 
Для выполнения действий по управлению клипами и монтажу фильма в Adobe

Premiere имеются следующие элементы интерфейса:
□ верхнее меню (menu bar) – строка меню, находящаяся под заголовком окна Adobe

Premiere (см. рис. 2.3);
□ контекстные (всплывающие) меню (context menu, pop – up menu) – меню, появляю-

щиеся при нажатии в том или ином месте правой кнопки мыши. Это особенно удобный спо-
соб редактирования, поскольку состав всплывающих меню зависит от того места, в котором
вы его вызываете, и вам легко найти в нем нужную команду (рис. 2.8);
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Рис. 2.8. Содержимое контекстного меню зависит от места его вызова

□ меню окон и палитр (window menu) – специфические меню, характерные для про-
дуктов компании Adobe и не очень привычные для пользователей других программ ОС
Windows. Эти меню вызываются нажатием кнопки с треугольной стрелкой, которую легко
отыскать в правой верхней части каждого окна и почти каждой палитры (рис. 2.9), и содер-
жат наборы команд, характерные для данного окна или палитры;

Рис. 2.9. Меню окна Project
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□ панели инструментов (toolbars) – многочисленные панели, размещенные в окнах и
комбинирующие различные элементы управления;

□ горячие клавиши (shortcuts) – очень эффективный способ для опытных пользова-
телей. Если вы часто применяете определенные команды, намного быстрее выполнять их
нажатием сочетания клавиш на клавиатуре, чем вызовом меню или инструментов;

□ активные надписи и регуляторы параметров — характерные элементы интер-
фейса, применяемые для регулировки различных числовых параметров. Например, одна из
таких надписей представляет собой тайм – код текущего кадра в окне Timeline (Монтаж)
(рис. 2.10). Числовое значение параметра, представленного активной надписью, как пра-
вило, можно изменить непосредственно с клавиатуры, щелкнув предварительно на надписи
мышью (рис. 2.11), а перетаскивание линии подчеркивания влево или вправо указателем
мыши уменьшает или увеличивает значение параметра соответственно (именно эта ситуа-
ция проиллюстрирована рис. 2.10).

Некоторые регуляторы параметров выполнены в виде характерных индикаторов, поз-
воляющих визуальным способом корректировать их значение (см. урок 12);

Рис. 2.10. Активная надпись

Рис. 2.11. Ввод значения тайм – кода с клавиатуры

□ вложенные списки — еще одна деталь интерфейса, характерная для сложных про-
грамм, позволяющая представить в компактной форме группы сходных по смыслу парамет-
ров того или иного объекта. Вложенные списки устроены в виде иерархической последова-
тельности списков, объединяющих группы сходных по смыслу параметров. Для того чтобы
развернуть скрытую часть вложенного списка, достаточно щелкнуть на характерной тре-
угольной кнопке, обращенной вправо (рис. 2.12). Для скрытия развернутого списка также
следует щелкнуть на данной кнопке, которая в этом случае будет направлена вниз.
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Рис. 2.12. Эффекты, имеющиеся в Premiere, организованы в виде иерархического вло-
женного списка закладки Effects

Все окна являются связанными тем или иным способом, поэтому, проводя редактиро-
вание фильма в одном из них, вы изменяете и состояние других окон.

Важным элементом интерфейса Premiere является указатель мыши. В зависимости
от места, на которое он наведен, и выбранных сочетаний опций окна (например, при том
или ином активном инструменте) указатель выглядит по – разному. Если вы поработаете с
Premiere некоторое время, то привыкнете к внешнему виду указателя, что будет помогать
вам увереннее ориентироваться в возможностях редактирования в каждый момент времени.

 
2.1.4. Справочная система

 
Для получения англоязычной справочной информации в процессе работы с Premiere

имеется очень удобная и исчерпывающая система помощи.
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Рис. 2.13. Справка Premiere

Для ее вызова используйте команду Help>Contents (Справка>Содержание). Справка
построена в гипертекстовом формате, и для ее просмотра загружается окно браузера
(рис. 2.13). В нем вы видите три панели – верхнюю (с заголовком), левую (с оглавлением)
и основную правую (со справочными статьями). Отыскивая в левой панели нужную главу
и затем, путешествуя по гиперссылкам правой панели, вы без труда найдете необходимую
вам статью.

Справочная система состоит из следующих составных частей:
□ Contents (Содержание) – статьи справки Premiere, расположенные по порядку в соот-

ветствии с оглавлением;
□ Index (Индекс) – выбор статьи из алфавитного указателя (рис. 2.14). Выберите

первую букву слова из алфавита в левой панели, а затем отыщите в открывшемся списке
нужное слово и щелкните на сопровождающей его гиперссылке;
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Рис. 2.14. Алфавитный указатель терминов Premiere

□ Search (Поиск) – поиск статей по ключевому слову (введите слово в поле ввода в
левой панели и нажмите клавишу <Enter>);

□ How to use Help (О справке) – получение информации о работе со справочной систе-
мой.

Если вы неплохо владеете английским языком, не пренебрегайте справочной системой
– она окажет вам существенную помощь, поскольку буквально в несколько щелчков мыши
вы найдете в ней интересующую вас статью, сопровождающуюся прекрасными иллюстра-
циями и примерами.
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2.2. О монтаже в Premiere

 
Работу по монтажу фильма в Premiere можно разбить на следующие составные части:
1. Создание нового проекта, включая определение его основных установок (см. уроки

4, 5).
2. Подготовка исходных файлов и импорт их в проект (см. уроки 6, 7).
3. Монтаж фильма из клипов, импортированных в проект (см. уроки 8, 11).
4. Возможно добавление различных спецэффектов (см. уроки 12, 13).
5. Добаление титров при необходимости (см. урок 14).
6. Экспорт смонтированного фильма (см. урок 15).

 
2.2.1. Проекты

 
Управление процессом монтажа отдельного фильма в рамках работы с Premiere

построено на основе понятия проекта (project). Проект является естественным объедине-
нием создаваемых вами фильмов и является своеобразной записью программы действий по
монтажу их элементов – клипов. По аналогии, к примеру, с программой Microsoft Word,
фильм в Premiere соответствует по смыслу документу Word. Только в последнем вы создаете
печатный текст, а в проекте Premiere – видеофильм.

Примечание
Аналогия с Microsoft Word не вполне оправдана. В отличие от

большинства многооконных компьютерных приложений, в Premiere нельзя
одновременно редактировать несколько проектов, однако, начиная с версии
Premiere Pro, в рамках одного проекта можно редактировать несколько
различных фильмов. Но даже при монтаже нескольких фильмов вы всегда
имеете дело только с одним проектом. Это связано с определенной
сложностью программы Premiere, средства видеомонтажа которой сами
по себе включают большое количество окон, выполняющих различные
функции. Поддержка возможности одновременного редактирования
нескольких проектов создала бы неизбежную путаницу для пользователя. К
тому же появившаяся возможность работы с несколькими фильмами решила
проблему поддержки многозадачности, отсутствовавшей в прежних версиях
Premiere.

При загрузке Premiere (см. рис. 2.3) мы создали новый проект. По умолчанию он уже
содержит один фильм, и ваша задача – поместить в проект необходимые файлы, из которых
вы собираетесь монтировать фильм, или в терминах видеомонтажа – клипы. Поэтому необ-
ходимо иметь видео-, аудио – или графические файлы на своем компьютере, работая с кото-
рыми в итоге вы получите фильм.

Альтернативой предварительной подготовки файлов является их непосредственная
оцифровка в Premiere. Для этого ваш компьютер должен быть оснащен специальными сред-
ствами передачи и обработки видеосигнала с внешнего устройства, такого как видеомагни-
тофон, видеокамера, TV – антенна и т. п. (см. урок 6). В любом случае перед тем как начать
монтаж фильма, вы должны иметь его исходные составляющие – клипы.
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Рис. 2.15. Выберите в диалоговом окне Import файл, который вы собираетесь импор-
тировать в проект

Чтобы лучше разобраться в принципах монтажа в Premiere, выполним простую опера-
цию импортирования клипа. Для этого нам потребуется любой видеофайл, находящийся в
какой – либо папке на вашем диске.

1. Выберите в верхнем меню File>Import (Файл>Импорт).
2. В открывшемся диалоговом окне Import (Импорт) перейдите к нужной папке и

выделите в ней файл, который вы собираетесь импортировать. В нашем случае это файл
cyclers.avi (рис. 2.15).

3. Нажмите кнопку ОК.
В результате клип появляется в окне Project (Проект) (рис. 2.16), и его можно исполь-

зовать для вставки в фильм.
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Рис. 2.16. Импортированный файл появляется в проекте в виде клипа

Повторимся, что основными понятиями при работе с проектами являются:
□ исходные клипы (clip), или источники (source) – ссылки на анимационные (видео),

звуковые (аудио) либо графические (статические изображения) файлы, для использования
которых в проекте их необходимо прежде импортировать из файлов с диска вашего ком-
пьютера или оцифровать с внешнего устройства;

□ фильм (sequence) или программа (program) – собственно продукт ваших действий
по монтажу исходных клипов. Вы можете просматривать фильм в правой половине окна
Monitor (Монитор) или экспортировать его во внешний медиа – файл, что, чаще всего,
является конечной целью вашей работы.

После того как клипы окажутся в специально предназначенном для них окне Project
(Проект), их можно перенести в окно Timeline (Монтаж), вставляя тем самым в фильм. Дей-
ствия пользователя по монтажу фильма могут включать такие операции, как разрезание кли-
пов, изменение их длительности, назначение различных эффектов, добавление титров и
т. д. Готовые фильмы просматриваются и экспортируются на жесткий диск в виде файла.
При наличии соответствующей аппаратуры их можно также вывести на внешнее цифровое
видеоустройство.

 
2.2.2. Клипы и фильмы

 
Клипы делятся на несколько типов:
□ Video (Анимация);
□ Audio (Звук);
□ Image (Статическое изображение);
□ Title (Титры);
□ специальные клипы (такие, как черный экран, настроечная таблица и т. п.);
□ Sequence (Фильм) – с некоторой натяжкой фильмы тоже можно считать клипами, с

точки зрения возможности их вставки друг в друга.
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Чтобы использовать клипы при монтаже, необходимо поместить (импортировать) их в
окно Project (Проект) (см. разд. 6.1). После завершения монтажа фильма его следует экспор-
тировать во внешний медиа – файл, т. е. записать файл на диск компьютера. Фильм создается
с установками, которые вы определяете предварительно (например, частота кадров, каче-
ство сжатия и т. д.). При этом клипы могут иметь существенно другие установки (например,
размер кадра или качество звука). Поэтому в процессе экспорта Premiere совершает слож-
ные математические операции по пересчету программы монтажа над исходными клипами,
составленной вами в процессе работы над проектом и записанной в символическом виде в
окне Timeline (Монтаж). Время экспорта может быть весьма продолжительным, поскольку
приходится пересчитывать каждый пиксел для каждого кадра фильма. Для вас эта работа
остается как бы «за кадром».

Появление клипа в окне Project (Проект) означает лишь, что между проектом и содер-
жимым соответствующего медиа – файла установлена связь, позволяющая «скачивать»
информацию из файла. Следует подчеркнуть, что по мере работы с клипами в Premiere с
самими файлами на дисках компьютера ничего не происходит. Premiere лишь считывает из
них информацию в проект, а затем (в соответствии с действиями пользователя по монтажу
фильма) обрабатывает ее с тем, чтобы представить скомпилированное изображение кадра
фильма в окне Monitor (Монитор).

Рис. 2.17. Для вставки клипа в фильм перетащите его из окна Project в окно Timeline

Импорт клипа в проект вовсе не означает его немедленную вставку в фильм. Проекты,
содержимое которых мы видим в окне Project (Проект), являются лишь библиотекой кли-
пов и фильмов. Для того чтобы включить клип в фильм, следует выполнить дополнитель-
ное действие: перенести его из окна Project (Проект) в окно Timeline (Монтаж). Делается
это при помощи простого перетаскивания клипа указателем мыши (рис. 2.17). Сразу сле-
дует отметить, что редактирование фильма в Premiere предусматривает привязку располо-
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жения клипов ко времени фильма (к номеру кадра). Для этих целей в правой части окна
Timeline (Монтаж) находится временная шкала или линейка времени (time ruler), определя-
ющая место каждого клипа в фильме. Поэтому при перетаскивании можно сразу располо-
жить клип в нужном месте окна Timeline (Монтаж) относительно линейки времени. После
того как кнопка мыши будет отпущена, клип возникнет в окне Timeline (Монтаж), а обнов-
ленное изображение текущего кадра появится в окне Monitor (Монитор) (рис. 2.18).

Примечание
В отличие от предыдущих версий программы, компиляция кадра

в Premiere Pro осуществляется в режиме реального времени (настолько
быстро, насколько позволяет быстродействие компьютера). Если ваш
компьютер обладает достаточно мощным процессором и большим объемом
оперативной памяти, то время компиляции (рендеринга) текущего кадра
будет незаметным для пользователя, даже если кадр содержит сложные
эффекты наложений, переходов и т. д.

Рис. 2.18. Результат вставки клипа в фильм

Таким образом, один из кадров фильма всегда является выделенным, что отображается
при помощи линии редактирования (editing line) и индикатора текущего кадра (current –
time indicator), выполненного в виде ползункового регулятора (рис. 2.18). Линия редакти-
рования является элементом интерфейса, характерным практически для всех видеоредак-
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торов, которая представляет собой вертикальную линию, пересекающую шкалу времени в
окне Timeline (Монтаж) в определенном месте. Таким образом, из всего фильма в каждый
момент времени выделяется один из кадров, имеющий особое значение (мы его будем назы-
вать текущим кадром). Тайм – код текущего кадра приводится в левой верхней части окна
Timeline (Монтаж) (см. рис. 2.11, 2.18) в виде активной надписи (выполненной с подчерки-
ванием).

Выделение текущего кадра в Premiere имеет то же назначение, что и курсор, отмечаю-
щий определенное место в тексте при работе в текстовых редакторах (например, Microsoft
Word или Notepad). Изображение текущего кадра демонстрируется в правой части окна
Monitor (Монитор), а большинство операций по редактированию фильма применимо как
раз к текущему кадру.

Обратите внимание на изменения, которые происходят в палитрах Info (Информация)
и History (Журнал) по мере того, как вы производите определенные действия (рис. 2.19).

Рис. 2.19. По мере редактирования фильма в палитрах отображается вспомогательная
информация

В палитре History (Журнал) отображается перечень последних операций, которые
были произведены в рамках редактирования проекта. Во – первых, это может служить
дополнительной помощью при вашей работе с Premiere, а во – вторых, вы можете с лег-
костью отменить любую последовательность действий в данной палитре. Стоит выделить
в фильме какой – либо объект (например, клип, вставленный нами в окно Timeline), и в
палитру Info (Информация) загрузится перечень сведений, относящихся к этому объекту,
что также сильно облегчает монтаж.

Таким образом, процесс монтажа фильмов в Premiere заключается в расположении
исходных клипов вдоль временной шкалы и последующем их редактировании, включая под-
гонку, вырезание и применение разнообразных спецэффектов. Фактически то, что мы видим
в соответствующей закладке окна Timeline (Монтаж), является исчерпывающей записью
редактируемого нами фильма и однозначно определяет вид каждого кадра. Сам кадр отоб-
ражается в окне Monitor (Монитор).
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2.3. Работа с несколькими фильмами

 
Как уже было сказано выше, Premiere позволяет редактировать одновременно

несколько фильмов (которые могут быть как совершенно независимыми, так и являться
составными частями друг друга).

Примечание
Помните, что в Premiere Pro (как и в Adobe After Effects 6) можно иметь

в открытом виде только один проект. Однако сам проект может содержать
любое количество фильмов.

Пока наш проект содержит один фильм, возникший автоматически при создании про-
екта и включающий единственный видеоклип. Добавим в проект еще два пустых фильма,
чтобы получить навык работы с Premiere в режиме многозадачности. Затем мы вставим в
один из новых фильмов наш фильм в виде составной части. Такой способ монтажа, при
котором фильмы вставляются друг в друга, называется вложенным редактированием (nested
edit).

Для создания нового фильма в Premiere предусмотрено несколько альтернативных воз-
можностей, и мы продемонстрируем две из них, которые наиболее удобны:

1. Нажатием правой кнопки мыши вызовите из пустой области списка в окне Project
(Проект) всплывающее (контекстное) меню и выберите в нем пункт New Item>Sequence
(Создать>Фильм) (рис. 2.20).

2. В открывшемся диалоговом окне New Sequence (Создание фильма) нажмите кнопку
ОК, не меняя параметров, предложенных по умолчанию (рис. 2.21). В результате новый
фильм появится в окне Project (Проект) (рис. 2.22).
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Рис. 2.20. Создание нового фильма при помощи контекстного меню

Рис. 2.21. Перед созданием фильма необходимо определить его установки

3. Для создания еще одного фильма нажмите кнопку New Item (Создать) на панели
инструментов окна Project (Проект). В появившемся всплывающем подменю выберите
пункт Sequence (Фильм) (см. рис. 2.22). Затем нажатием кнопки ОК закройте появившийся
диалог New Sequence (Создание фильма).
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Рис. 2.22. Создание нового фильма при помощи панели инструментов окна Project

Результатом этих действий будет создание двух новых пустых фильмов, которые
появятся в списке окна Project (Проект), а также откроются при помощи соответствующих
закладок в окнах Timeline (Монтаж) и Monitor (Монитор) (рис. 2.23).

Для перехода от одного фильма к другому в том или ином окне необходимо щелкнуть
на нужной закладке (рис. 2.24).
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Рис. 2.23. Новые фильмы открываются в окнах Monitor и Timeline

Рис. 2.24. Листание существующих фильмов в окне Timeline

Для того чтобы закрыть тот или иной фильм в окнах Timeline (Монтаж) и Monitor
(Монитор), достаточно нажать маленькую кнопку закрытия закладки, расположенную на
ней справа от имени соответствующего фильма (рис. 2.25). Чтобы впоследствии вновь загру-
зить скрытый фильм в окно Timeline (Монтаж) и Monitor (Монитор), следует дважды щелк-
нуть на его названии в списке окна Project (Проект).
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Рис. 2.25. Скрытие фильмов в окне Timeline производится нажатием кнопки закрытия
закладки

Иногда бывает полезным иметь на экране одновременно два (или больше) экземпляра
окна Timeline (Монтаж), в каждом из которых будет открыт свой фильм для редактирования.
Для этого следует разделить окно Timeline (Монтаж) следующим образом:

1. Схватитесь указателем мыши за закладку того фильма, который вы хотите открыть
в новом окне, например, Sequence 04.

2. Перетащите эту закладку (т. е. не отпуская левой кнопки мыши, переместите указа-
тель) на любое свободное место экрана.

3. Отпустите левую кнопку мыши.

Рис. 2.26. Для разделения окна Timeline перетащите закладку одного из фильмов за
пределы окна

В результате на экране появится дубликат окна с открытым в нем фильмом (рис. 2.26).
Для того чтобы соединить открытые в разных окнах фильмы, схватитесь за закладку с име-
нем фильма в одном из окон Timeline (Монтаж) и перетащите ее на область закладок дру-
гого окна.
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Рис. 2.27. Вставка одного фильма в другой (фильма Sequence 01 в Sequence 05)

Рис. 2.28. Текущий фильм содержит другой фильм в качестве составной части

Рассмотрим теперь, как производится вставка одних фильмов в другие. Для примера
вставим фильм Sequence 01 в пустой пока фильм Sequence 05:

1. Откройте фильм Sequence 05 в окне Timeline (Монтаж) щелчком на соответствую-
щей закладке.

2. Схватитесь за название фильма Sequence 01 в окне Project (Проект) и перетащите
его в графическую область (под шкалой времени) окна Timeline (Монтаж) (рис. 2.27).

В результате фильм Sequence 01 будет вставлен в фильм Sequence 05 (рис. 2.28).
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Урок З

Быстрый старт: монтаж простого фильма
 

Проиллюстрируем основные принципы работы в Premiere на примере создания про-
стого фильма. Большинство совершаемых операций мы приведем без чрезмерных поясне-
ний, учитывая, что соответствующим приемам монтажа будут посвящены последующие
уроки книги.

□ Чего мы хотим:
• создать простой фильм, состоящий из нескольких клипов различного типа, сценарий

которого приведен в разд. 3.2.
□ Нам потребуется:
• несколько файлов различных типов: три видео-, один аудио – и один графический

файл. В их качестве можно взять несколько файлов, поставлявшихся с прежними верси-
ями Adobe Premiere (они находились в папке Samples, вложенной в установочную папку
Premiere).

□ Что полезно вспомнить:
• как начинается работа в Premiere;
• как осуществляется импорт клипов в проекты и последующая вставка клипов в фильм

(см. урок 2).
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З.1. Подготовка к монтажу фильма

 
Посвятим этот урок линейному монтажу простого фильма, что позволит получить пер-

вые навыки по работе в Premiere.
 

З.1.1. Создание нового проекта
 

Начнем монтаж фильма с «чистого листа», создав для этого новый пустой проект:
1. Выберите в верхнем меню команду File>New>Project (Файл>Создать> Проект).
2. В открывшемся диалоговом окне New Project (Создание проекта) задайте имя нового

проекта, например – Tour, в поле Name (Название).
3. Выберите предустановку DV — PAL – Standart 32kHz (Цифровое видео – стандарт

PAL – Стандартный звук 32 кГц) и нажмите кнопку ОК.
В результате в окне Premiere откроется новый проект, название которого будет отобра-

жено в заголовке главного родительского окна Premiere. Проект уже содержит пустой фильм
Sequence 01, монтаж которого мы будем осуществлять на данном уроке.

Перед тем как начать монтаж, настроим интерфейс программы, чтобы иметь возмож-
ность проводить редактирование с большим удобством. Для этого в Premiere имеется спе-
циальное средство, называемое установками рабочей области окна (workspace). В зависи-
мости от характера предполагаемых действий бывает удобно расположить многочисленные
дочерние окна в определенном порядке. Несколько соответствующих установок встроено в
программу разработчиками Adobe Premiere – мы воспользуемся одной из них.

Рис. 3.1. Начните с настройки комфортабельности рабочей области Premiere при
помощи команды Window>Workspace
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В верхнем меню Window (Окно) наведите указатель мыши на пункт Workspace (Рабо-
чая область) и в появившемся подменю выберите установку Editing (Монтаж).

После этого места расположения и размеры дочерних окон перестроятся в соответ-
ствии с выбранной установкой рабочей области и станут примерно такими, как показано на
рис. 3.1.

 
3.1.2. Импорт клипов в проект

 
Как уже было сказано на прошлом уроке, перед монтажом фильма необходимо доба-

вить в проект его исходные составляющие – видео – и аудиоклипы. Этот процесс называется
в Premiere импортом. Импортируем в проект все необходимые файлы.

1. Выберите в верхнем меню File>Import (Файл>Импорт).
2. В открывшемся диалоговом окне Import (Импорт) отыщите на своем жестком диске

медиа – файлы, которые вы собираетесь импортировать.
3. При помощи кнопки View Menu (Меню Вид) настройте представление списка фай-

лов диалогового окна Import (Импорт) в виде Thumbnails (Миниатюры) (рис. 3.2).
4. Выделите в диалоговом окне Import (Импорт) все нужные для импорта в проект

файлы. Для выделения нескольких файлов пользуйтесь щелчками мыши при удерживаемой
клавише <Ctrl>. Если вы работаете с примерами из прошлых версий Premiere, то выберите
следующие файлы:

• анимационные файлы Boys.avi, Cyclers.avi, Fastslow.avi;
• звуковой файл Music.aif;
• графический файл Veloman.eps.
5. Нажмите в диалоговом окне Import (Импорт) кнопку Open (Открыть).
После этого диалоговое окно Import (Импорт) закроется, а все клипы окажутся в

окне Project (Проект) (рис. 3.3). Напомним еще раз, что после импорта мы будем называть
импортированные файлы клипами (с теми же самыми именами), подчеркивая, что они стали
частью нашего проекта.

Если вы не работали с предыдущими версиями Premiere, и перечисленных файлов у
вас нет, то можно использовать любые другие, имеющиеся у вас на компьютере файлы под-
ходящих форматов. Надо лишь, чтобы их содержимое хотя бы в общих чертах соответство-
вало сценарию фильма (см. разд. 3.2.1). Для того чтобы вам было удобнее разбираться в
описании основных приемов работы с Premiere, можно предварительно переименовать ваши
файлы, дав им названия Boys.avi, Cyclers.avi и т. д.
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Рис. 3.2. В диалоговом окне Import удобно использовать представление файлов в виде
миниатюр (для ОС Windows ХР)

Рис. 3.3. Файлы импортированы в проект в виде клипов
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Для того чтобы наша работа не пропала, не забывайте периодически сохранять про-
екты (подобно тому, как вы сохраняете файлы с документами Microsoft Word) – выберите в
верхнем меню File>Save (Файл>Сохранить).

 
3.1.3. Просмотр исходных клипов в окнах Project и Monitor

 
Мы будем составлять простой фильм из нескольких только что импортированных кли-

пов. Предварительно имеет смысл просмотреть исходные клипы, чтобы определиться со
сценарием фильма. Для этого выполните следующие действия:

1. Выберите какой – либо анимационный или графический клип, щелкнув на его назва-
нии в окне Project (Проект).

2. Наблюдайте первый кадр клипа в миниатюре предварительного просмотра окна
Project (Проект) (рис. 3.3, 3.4).

Рис. 3.4. Предварительный просмотр содержимого клипов возможен в миниатюре в
окне Project

3. С помощью кнопки Play (Проиграть) слева от миниатюры предварительного про-
смотра (на рис. 3.4 на нее наведен указатель мыши) просмотрите содержимое видеоклипа.

4. Увеличьте размер окна Project (Проект), чтобы оно стало шире и отобразило
столбцы, которые до этого были скрыты (рис. 3.5). Воспользуйтесь также горизонтальной
полосой прокрутки, чтобы просмотреть, какие столбцы имеются в списке окна Project (Про-
ект) и какую информацию о клипах они содержат.

5. Чтобы просмотреть клип более детально, откройте его в левой половине окна
Monitor (Монитор), предназначенной для просмотра исходных клипов. Для этого дважды
щелкните на пиктограмме слева от названия клипа в окне Project (Проект).
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Рис. 3.5. Атрибуты клипов просматриваются в соответствующих столбцах окна Project

6. В окне Monitor (Монитор) (рис. 3.6) просмотрите содержимое клипа с помощью
кнопки Play (Проиграть), находящейся в центре панели инструментов в нижней части окна.

Рис. 3.6. Просмотр клипа в окне Monitor

7. Закройте исходный клип в окне Monitor (Монитор) нажатием кнопки закрытия
закладки.

8. Просмотрите таким же образом и все остальные клипы, включая звуковой и стати-
ческий.

Примечание 1
Как вы помните, правая часть окна Monitor (Монитор) предназначена

для просмотра фильмов.

Примечание 2 – для пользователей предыдущих версий
В предыдущих версиях программы Premiere исходные клипы можно

было открывать и в отдельных окнах Clip (Клип). В версии Premiere Pro
клипы открываются только в левой части окна Monitor (Монитор).
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3.2. Монтаж фильма

 
Составляющие фильма импортированы в проект, и можно приступать к его монтажу

из подготовленных клипов. Создадим простой десятисекундный фильм из заставки, двух
видеоклипов и музыкального фрагмента.

 
3.2.1. Сценарий

 
Теперь, когда вы представляете себе содержимое клипов, сочиним простой сценарий

фильма. Мы предлагаем следующую последовательность планов:
1. Статическая заставка (клип Veloman.eps), длительность плана 3 с, без звука.
2. Черно – белое изображение ребенка на велосипеде (клип Boys.avi) на фоне медлен-

ного участка музыки (начало клипа Music.aii).
3. Резкая смена плана: цветное изображение участников велогонки (клип Cyclers.avi)

под ритмичную музыку (громкая часть клипа Music.aif).
4. Спецэффект перехода при смене следующих планов велогонки: растворение изоб-

ражения клипа Cyclers.avi в клипе Fastslow.avi. Музыка та же самая, ритмичная.
Пускай общая длительность фильма определяется длительностью первых двух участ-

ков музыки.
Для того чтобы вставить исходный клип в фильм, необходимо перенести его из окна

Project (Проект) в окно Timeline (Монтаж) при активной закладке нужного фильма. После
этого можно будет отредактировать клип желаемым образом.

В окне Timeline (Монтаж) клипы размещаются на треках, или дорожках, т. е. горизон-
тальных полосах, расположенных вдоль линейки времени. Окно Timeline (Монтаж) содер-
жит треки двух типов: видео – и аудиотреки. Все аудиотреки равнозначны (порядок их сле-
дования не имеет значения), поскольку звук со всех аудиотреков микшируется в одинаковой
пропорции. Напротив, порядок расположения видеотреков играет ключевую роль в фор-
мировании фильма. Итоговое изображение кадра фильма образуется благодаря наложению
видеотреков друг на друга в том порядке, в котором они расположены в окне Timeline (Мон-
таж) – снизу вверх. Конечно, для того, чтобы изображение с нижних треков «проступало»
в кадре фильма, для верхних треков должен быть назначен соответствующий режим про-
зрачности, либо они должны быть масштабированы определенным образом. При монтаже
простого фильма мы не будем касаться этих возможностей программы Premiere, оставив их
рассмотрение до будущих глав.

 
3.2.2. Монтаж заставки

 
Начнем создание фильма с монтажа заставки:
1. Наведите указатель мыши на пиктограмму клипа Veloman.eps в окне Project (Про-

ект).
2. Перетащите клип Veloman.eps, нажимая и удерживая левую кнопку мыши на его

пиктограмме, из окна Project (Проект) в окно Timeline (Монтаж) в начало трека Video 1
(рис. 3.7). Место возможной вставки клипа в фильм будет отображаться в виде прямоуголь-
ника, а указатель мыши приобретет характерный вид, говорящий о возможности вставки
клипа в фильм.

3. Отпустите кнопку мыши, когда символическое прямоугольное представление клипа
в окне Timeline (Монтаж) зафиксируется на нулевой отметке шкалы времени.
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Теперь клип вставлен в окно Timeline (Монтаж) и является частью фильма. Клип,
вставленный в окно Timeline (Монтаж), называют также экземпляром клипа, чтобы отличать
от исходного мастер – клипа из окна Project (Проект). Обратите внимание, что измененный
кадр фильма, который уже содержит изображение статического клипа, показывается в окне
Monitor (Монитор) (рис. 3.8). В этом окне можно как проиграть фильм при помощи типич-
ных кнопок управления воспроизведением, так и переместить текущий кадр на другое место
фильма (при помощи активной надписи тайм – кода, на которую наведен указатель мыши
на рис. 3.8).

Рис. 3.7. Перенос статического клипа в окно Timeline
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Рис. 3.8. Просмотр текущего кадра фильма осуществляется в правой половине окна
Monitor

Внимание
Запомните, что в правой половине окна Monitor (Монитор) вы видите

модельный кадр из фильма в уже смонтированном виде. Если окно Monitor
(Монитор) находится в режиме показа двух кадров, то кадр фильма показан
справа, а кадры исходных клипов – слева.

Рис. 3.9. Изменение масштаба времени в окне Timeline осуществляется при помощи
специального ползункового регулятора
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Несмотря на то, что клип с заставкой – это статическое изображение, он размещается в
окне Timeline (Монтаж) с некоторой длительностью. Согласно нашему сценарию, заставка
должна длиться в течение трех первых секунд фильма, т. е. другое время, нежели то, кото-
рое пока получается в окне Timeline (Монтаж). Для удобства редактирования длительности
клипа, возможно, вам стоит изменить масштаб временной шкалы.

При помощи перетаскивания ползунка регулятора масштаба времени в нижней части
окна Timeline (Монтаж) влево или вправо подберите желаемый масштаб шкалы времени
(рис. 3.9). Для тех же целей можно использовать и кнопки увеличения и уменьшения мас-
штаба, расположенные по бокам от данного регулятора.

Чтобы отредактировать длительность заставки, воспользуемся соответствующим
инструментом.

1. Щелкните на кнопке Selection (Выбор) с изображением стрелки в палитре Tools
(Инструментарий), если эта кнопка еще не нажата.

2. Наведите указатель мыши на правый край клипа Veloman.eps. Указатель примет вид
скобки со стрелками посередине (рис. 3.10).

3. Нажмите левую кнопку мыши и, удерживая ее, перетащите границу клипа на 3-
секундную отметку временной шкалы (как показано на рис. 3.10).

4. Отпустите кнопку мыши – длительность статического клипа станет равной 3 с.
Проделанная процедура называется подгонкой, или изменением длительности клипа.

Рис. 3.10. Изменение длительности заставки производится перетаскиванием края
клипа инструментом Selection

 
З.2.З. Монтаж звука

 
Перейдем к монтажу звукового клипа. Нам предстоит также перенести его в окно

Timeline (Монтаж) и уменьшить его длительность, оставив в фильме лишь начальную часть
клипа. Попутно мы будем настраивать окно Timeline (Монтаж), подбирая наиболее удобный
вид этого окна для нашей работы. Для этого выполните следующие шаги:

1. Раскройте все аудиотреки в окне Timeline (Монтаж), перетащив для этого вверх
линию раздела видео – и аудиотреков (рис. 3.11). Хвататься следует за левую часть раздели-
тельной линии, как это показано на рис. 3.11.
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Рис. 3.11. Подберите удобное соотношение размеров видео – и аудиотреков, перетас-
кивая линию их раздела

2. Перенесите аналогичным образом звуковой клип из окна Project (Проект) на
область аудиотреков, так, чтобы его левая граница выровнялась с правой границей клипа
Veloman.eps. В процессе перетаскивания положение клипа Music.aif в фильме, так же, как и
для видеоклипа, будет отображаться прямоугольником (рис. 3.12). После того как вы отпу-
стите кнопку мыши, клип будет вставлен на нижний аудиотрек, который, возможно, будет
создан автоматически (разговор о том, почему так происходит, отложим до урока II).

Рис. 3.12. Перенесите звуковой клип на аудиотрек окна Timeline

3. Поскольку мы не будем вставлять в фильм другие аудиоклипы, имеет смысл скрыть
пустые аудиотреки в окне Timeline (Монтаж). Для этого вызовите контекстное меню из обла-
сти заголовков треков окна Timeline (Монтаж), выберите в нем пункт Delete Tracks (Удалить
треки) и в появившемся диалоговом окне установите флажок Delete Audio Track(s) (Удалить
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аудиотрек(и)) (рис. 3.13). После нажатия в диалоге кнопки ОК пустые треки будут скрыты,
а звуковой клип останется на единственном аудиотреке Audio 1 в окне Timeline (Монтаж).

Рис. 3.13. Удалите пустые аудиотреки, чтобы они не загромождали окно Timeline

Рис. 3.14. Разверните график громкости звука для аудиотрека

4. Подберите подходящий временной масштаб. Для этого можно использовать регуля-
тор масштаба времени, а можно просто нажать клавишу <\>, чтобы наиболее подходящий
масштаб времени установился автоматически.

5. Для того чтобы ориентироваться в содержимом звукового клипа Music.aif, развер-
ните нажатием кнопки Collapse/Expand Track (Свернуть/Развернуть трек) амплитудный
график его интенсивности (рис. 3.14).

Теперь обратимся к редактированию длительности клипа в фильме. По графику интен-
сивности звука легко идентифицировать различные участки с громким и тихим звучанием.
Согласно сценарию, нам следует обрезать клип перед вторым тихим фрагментом (т. е. при-
мерно на 12-й секунде). Уменьшить длительность клипа можно описанным выше (для ста-
тического клипа – заставки) способом, перетаскивая его правую границу влево инструмен-
том Selection (Выбор) до нужной отметки на шкале времени. Однако мы поступим несколько
по – другому, чтобы научиться вырезать из клипа ненужные фрагменты. Выполните следу-
ющие действия:
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1. Выберите в палитре Tools (Инструментарий) инструмент Razor (Лезвие) (рис. 3.15).

Рис. 3.15. Для разрезания клипа выберите инструмент Razor

2. Наведите указатель мыши, который будет иметь вид инструмента Razor (Лезвие),
на нужное место клипа Music.aif в районе его 12-й секунды.

Рис. 3.16. Разрежьте клип щелчком инструментом Razor в соответствующем месте
клипа

3. Щелчком инструментом Razor (Лезвие) по клипу Music.aif разрежьте клип
(рис. 3.16). В результате клип разделится на два клипа с одним и тем же названием Music.aif,
однако, с точки зрения содержания фильма, ничего не произойдет.
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Рис. 3.17. Удалить клип из фильма можно при помощи команды Clear контекстного
меню

4. Удалите второй из клипов, вызывая на нем контекстное меню и выбирая в нем
пункт Clear (Удалить) (рис. 3.17). Результат удаления второго экземпляра клипа показан на
рис. 3.18.

Рис. 3.18. Результат удаления второго клипа с аудиотрека
 

3.2.4. Монтаж видео
 

Перейдем к монтажу видеоклипов. Выполните следующие шаги:
1. Последовательно перенесите клипы Cyclers.avi и Fastslow.avi на трек Video 1, рас-

положив их после клипа Veloman.eps.
2. Щелкните на кнопке Selection (Выбор) в палитре Tools (Инструментарий).
3. Уменьшите длительность клипа Cyclers.avi примерно до момента смены тихой

музыки клипа Music.aif громкой ритмичной музыкой (рис. 3.19).
4. Выделите щелчком пустой промежуток, образовавшийся между видеоклипами, и

вызовите из него контекстное меню (рис. 3.20).
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5. Выберите в контекстном меню пункт Ripple Delete (Удалить со сдвигом). В резуль-
тате пустой промежуток исчезнет за счет перемещения последнего клипа влево, в стык с
клипом Cyclers.avi.

Примечание
Можно было избавиться от пустого промежутка вручную, просто

перетащив клип Fastslow.avi влево инструментом Select (Выбор). Для этого
следует нажать левую кнопку мыши в середине клипа и, удерживая ее,
перемещать клип влево вдоль трека до момента его стыковки с клипом
Cyclers.avi.

Рис. 3.20. Отрегулируйте длительность видеоклипа инструментом Selekt

Рис. 3.20. Удалите со сдвигом пустой промежуток между видеоклипами при помощи
команды Ripple Delete

6. Выберите на панели инструментов инструмент Razor (Лезвие).
7. Разрежьте, в зависимости от того, какой клип длиннее, – клип Fastslow.avi вровень

со звуковым клипом или звуковой клип Music.aif вровень с Fastslow.avi. Удалите лишнюю,
правую, часть при помощи контекстного меню.
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3.2.5. Создание эффекта перехода

 
Добавим теперь спецэффект перехода, т. е. реализуем смену планов клипа Cyclers.avi

клипом Fastslow.avi. Для этого:
1. Откройте в окне Project (Проект) закладку Effects (Эффекты). Если закладка отсут-

ствует в этом окне, то вызовите ее командой Window>Effects (Окно>Эффекты).
2. Раскройте в появившемся списке эффектов папку Video Transitions (Видео Пере-

ходы) (рис. 3.21).

Рис. 3.21. Откройте в палитре Effects папку с эффектами переходов Video Transitions

3. Выберите в папке Video Transitions (Видео Переходы) желаемый переход. Напри-
мер, раскройте вложенную папку с переходами Dissolve (Растворение) и выделите в ней
переход Cross Dissolve (Перекрестное растворение).

4. Перетащите желаемый эффект перехода из окна с закладкой Effects (Эффекты) на
начало клипа Fastslow.avi в окне Timeline (Монтаж) (рис. 3.22). Переход будет обозначен
соответствующей пиктограммой в начале клипа.

5. Переместите линию редактирования на кадр в пределах перехода и просмотрите, как
он будет выглядеть в окне Monitor (Монитор) (рис. 3.23).
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Рис. 3.22. Для настройки перехода перетащите его из палитры Effects на клип в окне
Timeline

Рис. 3.23. Просмотр кадра фильма с переходом в окне Monitor

Таким образом, теперь при переходе действия между двумя видеоклипами создан спе-
цэффект растворения.
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Пользователям предыдущих версий
В предыдущих версиях программы Premiere переходы настраивались

на специальных треках переходов при помощи палитры Transitions
(Переходы). В Premiere Pro переходы организованы в виде эффектов, что
намного удобнее.



Е.  Н.  Кирьянова, Д.  В.  Кирьянов.  «Самоучитель Adobe Premiere Pro»

65

 
З.З. Просмотр и экспорт фильма

 
Просмотр фильмов в окне Monitor (Монитор) программы Premiere может осуществ-

ляться двумя способами:
□ статический просмотр – фактически это демонстрация текущего кадра в окне

Monitor (Монитор). Щелкая в том или ином месте на шкале времени в окне Timeline (Мон-
таж), протаскивая индикатор текущего кадра вдоль шкалы или перемещая линию подчерки-
вания активного поля тайм – кода в окне Monitor (Монитор), можно просматривать кадры
фильма в статическом режиме. Premiere в реальном времени производит расчет изображе-
ния текущего кадра и отображает его в окне Monitor (Монитор);

□ динамический просмотр – фильм проигрывается в динамике аналогично просмотру
видео в проигрывателях. Для управления воспроизведением в окне Monitor (Монитор)
используются стандартные кнопки, расположенные в нижней части области Sequence
(Фильм). Чтобы просмотреть получившийся фильм от начала до конца, можно просто
нажать клавишу <Enter>. После небольшого времени компиляции фильма, в течение кото-
рого процент выполнения расчетов показывается на индикаторе информационного окна
Rendering Files (Рендеринг файлов) (рис. 3.24), фильм будет воспроизведен в окне Monitor
(Монитор).

Рис. 3.24. В процессе рендеринга фильма для его предварительного просмотра отоб-
ражается окно Rendering Files

Для сохранения фильма во внешнем файле выполните следующие действия:
1. Выделите фильм в окне Project (Проект) или Timeline (Монтаж).
2. Выберите в верхнем меню команду File>Export>Movie (Файл>Экспорт> Фильм).
3. В открывшемся диалоговом окне Export Movie (Экспорт фильма) определите место-

расположение файла и его название (рис. 3.25).
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Рис. 3.25. При экспорте фильма необходимо задать название и месторасположение
файла в окне Export Movie

4. При желании измените установки экспорта, нажав кнопку Settings (Установки) и
отредактировав соответствующие параметры в открывшемся диалоговом окне.

5. Нажмите кнопку Save (Сохранить) в диалоговом окне Export Movie (Экспорт
фильма).

6. Наблюдайте за процессом экспорта, сопровождающимся показаниями индикатора
информационного окна Rendering Files (Рендеринг).

7. По завершении экспорта просмотрите созданный файл, который будет добавлен в
окно Project (Проект) автоматически. Просмотр можно осуществить в правой части окна
Monitor (Монитор), дважды щелкнув для этого на имени файла в окне Project (Проект).
Обратите внимание, что созданный файл просматривается именно в области клипов окна
Monitor (Монитор) слева, т. к. уже является обычным клипом, считанным из внешнего
файла. В правой области окна Monitor (Монитор) по – прежнему демонстрируется скомпи-
лированный кадр фильма, соответствующий программе окна Timeline (Монтаж).
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Рис. 3.26. После завершения экспорта созданный файл добавляется в проект, и его
можно просмотреть в области клипов окна Monitor

Таким образом, мы полностью выполнили сценарий по монтажу простого фильма из
некоторых клипов и познакомились на его примере с основными этапами создания фильмов
в Premiere.
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Урок 4

Установки
 

Урок посвящен одному из центральных моментов цифрового видеомонтажа – правиль-
ному определению установок будущего видеофильма, таких как размер кадра, частота кад-
ров, параметры сжатия и т. п., а также соответствующим настройкам проекта, влияющим на
среду редактирования фильма.

□ Чего мы хотим:
• научиться правильно задавать установки проекта и экспорта.
□ Нам потребуется:
• только сама программа Adobe Premiere.
□ Что полезно вспомнить:
• как начинается работа над новым проектом Premiere (см. урок 2);
• как осуществляется экспорт фильма (см. урок 3).
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4.1.Типы установок

 

В Premiere используются три класса установок, задающих основные параметры
фильма для различных действий пользователя:

□ установки проекта (project settings) – определяют, как будет выглядеть фильм при
редактировании, и влияют только на предварительный просмотр фильма в окне Monitor
(Монитор) во время монтажа;

□ установки экспорта (export settings) – задают формат файла, в который экспортиру-
ется фильм по завершении монтажа;

□ установки оцифровки (capture settings) – влияют на формат файлов, в которые произ-
водится оцифровка видеосигнала с внешнего устройства, которое может быть подключено
к компьютеру.

Внимание
Таким образом, установки, выбираемые для проекта, не связаны с

параметрами видеофайла, в который вы, по завершении монтажа, будете
экспортировать фильм. Установки экспорта по составу очень похожи
на установки проекта, но задавать их необходимо непосредственно в
процессе экспорта (см. урок 15). Поэтому выбирайте установки проекта из
соображений удобства среды редактирования, находя компромисс между
близостью установок к финальным параметрам экспорта (чтобы оценивать
кадр в окне Monitor (Монитор) как кадр из фильма) и приемлемым
быстродействием компьютера.

Настройка установок проекта в Premiere осуществляется при его создании в диалого-
вом окне New Project (Создание проекта). Впоследствии многие установки проекта можно
отредактировать в диалоговом окне Project Settings (Установки проекта), вызывая его одно-
именной командой из меню Project (Проект). Установки экспорта определяются непо-
средственно в процессе экспорта фильма, начинающегося по команде File>Export>Movie
(Файл> Экспорт>Фильм). Далее на этом уроке будут подробно разобраны установки про-
екта, а читателю следует иметь в виду, что соответствующие установки экспорта и оциф-
ровки имеют тот же самый смысл (конечно, с той поправкой, что относятся не к проекту, а
к ренедерингу фильма или оцифровке клипов с внешнего устройства).

Все три класса установок проекта схожи между собой и делятся на несколько типов:
□ General (Общие) – настраивают среду редактирования Premiere;
□ Video (Видео) – ответственны за размер и частоту кадров, качество картинки и

эффективность сжатия видеоинформации;
□ Audio (Аудио) – характеристики звука, сопровождающего фильм;
□ Video Rendering (Рендеринг видео) – определяют кодек, который будет использо-

ваться для сжатия видеоинформации, и задают различные опции компрессии;
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□ Capture (Оцифровка) – определяют установки, с которыми Premiere преобразует
видеосигнал с внешнего устройства, подключенного к компьютеру (например, камеры или
видеомагнитофона);

□ Default Sequence (Фильм по умолчанию) – задают количество треков, появляющихся
в окне Timeline (Монтаж) для новых фильмов, создаваемых в проекте.

Параметров, определяющих установки, довольно много, и каждый раз, когда вы начи-
наете новый проект или осуществляете экспорт смонтированного фильма, просматривать и
редактировать каждую установку весьма трудоемко. Поэтому разработчики Premiere преду-
смотрели специальное средство, которое упрощает применение установок (как проекту,
так и оцифровке и экспорту). Комбинации установок можно сохранить в Premiere в каче-
стве соответствующей настройки, называемой предустановкой (preset). Разработав еди-
ножды необходимые вам предустановки, впоследствии их можно выбирать «в один щел-
чок» из соответствующего списка и необязательно определять каждую установку вручную.
В Premiere встроено несколько предустановок, которые можно использовать в вашей работе.
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4.2. Установки проекта

 
Рассмотрим, как производятся выбор установок при создании нового проекта и изме-

нение установок проекта, над которым вы уже работаете. Каждый раз в начале работы над
новым проектом (в том числе, и при запуске программы Premiere, после выбора в окне – при-
глашении опции создания нового проекта) перед вами возникает окно New Project (Созда-
ние проекта), в котором необходимо определить установки создаваемого проекта (рис. 4.1).

Рис. 4.1. В диалоговом окне New Project следует определить установки создаваемого
проекта

Это диалоговое окно содержит две закладки, предоставляющие пользователю две аль-
тернативные возможности выбора установок:

□ Load Preset (Загрузить предустановку) – выбор одной из имеющихся в Premiere
предустановок;

□ Custom Settings (Настройка установок) – задание установок вручную.
Внимание
В Premiere Pro следует намного серьезнее, чем в предыдущих версиях,

относиться к выбору установок создаваемого проекта. Некоторые из них
впоследствии поменять не удастся.

Помимо элементов управления для задания тех или иных установок, окно New Project
(Создание проекта) содержит ряд командных кнопок, позволяющих реализовать следующие
возможности:
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□ ОК – подтверждение выбора установок и создание нового проекта с этими парамет-
рами;

□ Cancel (Отмена) – выход из диалогового окна без создания нового проекта с возвра-
щением к окну – приглашению;

□ Delete Preset (Удалить предустановку) – удаление выделенной в левой части диало-
гового окна предустановки (эта кнопка присутствует только на закладке Load Preset);

□ Save Preset (Сохранить предустановку) – сохранение комбинации текущих устано-
вок в качестве предустановки (только на закладке Custom Settings (Настройка установок));

□ Browse (Пролистать) – выбор папки на диске, в которую будет сохранен проект.
Примечание
Как вы помните, в полях Location (Расположение) и Name (Название)

окна New Project (Создание проекта) следует задать место на диске и имя
нового проекта соответственно.

 
4.2.1. Предустановки

 
На закладке Load Preset (Загрузить предустановку) список Available Presets
(Доступные предустановки) располагается слева. Переходя от одной предустановки

к другой, в правой части диалогового окна, на панели Description (Описание) вы увидите
ее описание, т. е. перечисление наиболее важных параметров аудио, видео и рендеринга.
Предустановки, как уже было сказано, нужны для быстрого задания комбинаций параметров
фильма, составленных ранее. Выбрав предустановку, можно затем изменить некоторые ее
параметры вручную, обратившись к закладке Custom Settings (Настройка установок).

Разработчиками Premiere скомпонованы два семейства установок, относящихся к тех-
нологии цифрового видео (Digital Video) и применяемых, главным образом, для записи на
DVD или непосредственной передачи видеосигнала с компьютера на подключенное к нему
внешнее цифровое устройство:

□ DV – NTSC (цифровое видео – североамериканский стандарт телевещания) – уста-
новки для теле – и видеопрограмм в стандарте NTSC;

□ DV – PAL (цифровое видео – европейский стандарт телевещания) – установки для
теле – и видеопрограмм в стандарте PAL (отличается от стандарта NTSC, в частности, раз-
мером кадра).

В соответствии с целью работы вам следует выбрать одну из этих предустановок из
списка, ориентируясь также на их дополнительные параметры (см. рис. 2.1). Стандарты циф-
рового видео отличаются частотой модуляции сигнала (наиболее популярные стандарты 32
и 48 кГц) и отношением размера экрана – Standard (Стандартный) и Widescreen (Широко-
экранный).

Впоследствии вы, скорее всего, будете использовать и свои собственные предуста-
новки, задав предварительно все параметры вручную и затем сохранив их в качестве пред-
установки (см. разд. 4.2.8).

 
4.2.2. Общие установки

 
Для того чтобы просмотреть и, при желании, поменять установки вручную, следует

перейти к закладке Custom Settings (Настройка установок) диалогового окна New Project
(Создание проекта) (рис. 4.2). Установки различных типов сгруппированы на несколь-
ких страницах, открывающихся в данной закладке при выборе определенного элемента
списка. На рис. 4.2 показана группа элементов интерфейса, настраивающих общие уста-
новки General (Общие).
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Общие установки связаны с выбором подходящей среды редактирования видео в зави-
симости от типа фильма, который вы намерены получить в результате монтажа.

Режим редактирования
Editing Mode (Режим редактирования) – раскрывающийся список, определяющий

метод, используемый для просмотра как исходных видеоклипов, так и готового фильма.
Главным образом режим редактирования определяет список доступных программ – ком-
прессоров, находящийся в установках видео. Имеются две основные возможности:

□ DV Playback (Воспроизведение на цифровом видео) – режим редактирования,
предусматривающий воспроизведение фильма как в окне Monitor (Монитор) Premiere, так и
на внешнем цифровом устройстве, специальным образом подключенном к вашему компью-
теру (применяется для подготовки фильмов в формате DV);

Рис. 4.2. Закладка Custom Settings диалогового окна New Project позволяет задать все
установки проекта вручную (включен режим редактирования проекта DV Playback)

□ Video for Windows (Видео для Windows) – режим редактирования, наиболее подхо-
дящий для пользователей ОС Windows (применяется, например, для подготовки мультиме-
дийных файлов для просмотра на компьютере);

□ возможно, в списке присутствуют другие режимы, предусмотренные программным
обеспечением устройств оцифровки, если они есть на вашем компьютере.

Режим DV Playback (Воспроизведение на цифровом видео) обеспечивает проигрыва-
ние фильма при помощи видеоплаты с DV – выходом либо встроенной платы оцифровки
на внешнем устройстве, например, видеокамере, цифровом телевизоре и т. п. При выборе
этого режима становится доступной кнопка Playback Settings (Установки воспроизведения)
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(см. рис. 4.2). Она вызывает диалоговое окно DV Playback Settings (Установки внешнего
воспроизведения), в котором задаются возможные способы параллельного проигрывания
фильма на внешнем устройстве (рис. 4.3). Более подробно об этих возможностях вы узнаете
из урока 15.

Рис. 4.3. Опции воспроизведения фильма на внешнем цифровом устройстве. Режим
редактирования проекта – DV Playback

Обратите внимание, что при выборе режима редактирования DV Playback (Воспроиз-
ведение на цифровом видео) многие установки (в частности, размер кадра) изменять нельзя,
поскольку они определяются самим стандартом Digital Video.

Если вы собираетесь создавать фильм для других целей, отличных от использова-
ния технологии DV, то следует выбрать режим Video for Windows (Видео для Windows)
(рис. 4.4).

Временная база
Раскрывающийся список Timebase (Временная база) задает способ отсчета времени

фильма, т. е. временные метки на шкале времени в окне Timeline (Монтаж) и Monitor
(Монитор), с помощью которых Premiere разбивает фильм (в том числе для вычисления вре-
менного положения линии редактирования).
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Рис. 4.4. На странице общих установок проекта выбран режим редактирования Video
for Windows

Предусмотрены следующие возможные значения временной базы:
□ 24 frames/second (24 кадра/с) – используется для создания кинофильмов на кино-

пленках;
□ 25 frames/second (25 кадров/с) – режим, подходящий для частоты кадров PAL/

SECAM, (европейского стандарта телевидения);
□ 29.97 frames/second (29.97 кадров/с) – режим для частоты кадров NTSC (североаме-

риканского стандарта телевидения);
□ 30 frames/second (30 кадров/с) – режим, применяемый для мультимедийных продук-

тов и других стандартов.
В зависимости от частоты кадров, которая будет использоваться в смонтированном

фильме, удобно выбирать то или иное значение временной базы. Если фильм будет воспро-
изводиться на теле – или видеосистеме стандарта PAL/SECAM (в частности, принятом в Рос-
сии), то он должен иметь частоту 25 кадров/с. Естественно, что для монтажа такого фильма
удобно использовать и временную базу 25 кадров/с, т. е. разбиение каждой секунды фильма
в окне Timeline (Монтаж) шкалой времени на 25 кадров (рис. 4.5).

Рис. 4.5. Окно Timeline при выбранной временной базе 25 кадров/с
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Подчеркнем, что Timebase (Временная база) – это установка, настраивающая лишь
окно Timeline (Монтаж) и не влияющая непосредственно на свойства вашего фильма. Для
примера сравните рис. 4.5 и рис. 4.6, демонстрирующие отличие во временной шкале окна
Timeline (Монтаж) при различных установках временной базы. На обоих рисунках линия
редактирования указывает на нулевой кадр первой секунды фильма, т. е. на кадр с тайм –
кодом 0:00:01:00. Но на рис. 4.5 секунда фильма включает 25 кадров, а на рис. 4.6, согласно
установленной временной базе, – 30 кадров. Это означает, что при временной базе 25 кад-
ров/с нулевая секунда включает кадры от 0:00:00:00 до 0:00:00:24, а при 30 кадров/с – кадры
от 0:00:00:00 до 0:00:00:29 соответственно. В этом легко убедиться, учитывая, что указа-
тель мыши на обоих рисунках наведен на последний кадр нулевой секунды фильма (а линия
редактирования отмечает, соответственно, нулевой кадр следующей секунды).

Рис. 4.6. Окно Timeline при выбранной временной базе 30 кадров/сек
 

4.2.3. Установки видео
 

На той же самой странице с общими установками имеется еще одна группа элементов
интерфейса Video (Установки видео) (см. рис. 4.2, 4.4). Перечислим эти установки:

□ два поля Frame Size (Размер кадра) – определяют размеры кадра в пикселах по гори-
зонтали и вертикали;

□ раскрывающийся список Pixel Aspect Ratio (Пропорции пиксела) – устанавливает
отношение размеров пиксела. В некоторых стандартах телевидения (например – DV NTSC,
DV 1), в отличие от компьютерных мониторов, используются не квадратные, а прямоуголь-
ные пикселы. В случае выбора неправильной пропорции пикселов изображение фильма при
просмотре его на мониторе соответствующего стандарта будет искаженным (вытянутым по
горизонтали или вертикали), но на экране монитора компьютера фильм может смотреться
правильно. Если вы не работаете в формате DV, то в большинстве случаев верным будет
выбор варианта Square Pixel (Квадратные пикселы), если же вы собираетесь демонстриро-
вать фильм на специальной телевизионной аппаратуре, обязательно сверьтесь со стандартом
пропорций пиксела, которые в ней используются;

□ раскрывающийся список Fields (Поля) – устанавливает различные форматы для вос-
произведения видео на внешнем устройстве (DV, NTSC, PAL или SECAM). Если вы монти-
руете фильм, тут же просматривая его на внешнем мониторе, то сверьтесь с руководством
по эксплуатации монитора, чтобы правильно выставить данную опцию;

□ раскрывающийся список Time Display Format (Формат отображения времени) –
определяет формат нумерации кадров на шкале времени в окне Timeline (Монтаж) и на
табло в окне Monitor (Монитор). Этот параметр тесно связан с общей установкой Timebase
(Временная база) и был подробно рассмотрен на вводном уроке (см. разд. 1.2);

О поля ввода числовых параметров Title Safe Area (Безопасная зона титров) и Action
Safe Area (Безопасная зона действия) – задают размер областей на кадре фильма (в процен-
тах от его полного размера), в пределах которых титры и картинка фильма будут переда-
ваться без искажений. Известно, что различная воспроизводящая телевизионная аппаратура
может несколько «обрезать» или исказить фильм на границах кадра. Для того чтобы пользо-
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ватель мог ориентироваться в величине безопасных областей, соответствующие рамки могут
отображаться в окне Monitor (Монитор);

□ Флажок Scale clip to project dimensions when adding to sequence
(Масштабировать клип при вставке в фильм) устанавливет, при вставке клипа в окно

Timeline (Монтаж), его масштабирование, подгоняя размер кадра клипа под размер кадра
фильма.

 
4.2.4. Установки аудио

 
Установки, определяющие параметры кодирования звука, выбираются в группе эле-

ментов Audio (Установки звука) той же страницы General (Общие) окна New Project (Созда-
ние проекта) (см. рис. 4.2, 4.4):

□ раскрывающийся список Sample Rate (Частота) – определяет частоту, с которой звук
представляется в цифровом виде. Например, частота 32000 Hz означает, что запись звука
производится с временным интервалом 1 / 32000 х 0.00003 с. Чем выше частота, тем, как
правило, лучше и естественнее звук;

Примечание
Старайтесь при экспорте фильма выбирать ту же (или худшую) частоту

звука, что и для исходного клипа. Если вы желаете увеличить частоту, вам
придется повторно оцифровать клип.

□ раскрывающийся список Display Format (Формат отображения звука) – опреде-
ляет формат измерения интенсивности звука на соответствующих амплитудных графиках.
Например, можно измерять время в сэмплах или миллисекундах, как это делается в боль-
шинстве традиционных звуковых редакторов.

 
4.2.5. Установки оцифровки и рендеринга

 
Установки проекта, находящиеся на странице Capture (Оцифровка), относятся к про-

цессу передачи изображения с внешнего устройства на компьютер. Раскрывающийся спи-
сок Capture Format (Формат оцифровки) (рис. 4.7) задает формат, в котором будет произ-
водиться видеозахват. По умолчанию в Premiere имеется формат DV, который соответствует
передаче цифрового видеосигнала через стандартный порт IEEE 1394. Если на вашем ком-
пьютере имеются иные устройства оцифровки (capture device), то список Capture Format
(Формат оцифровки) будет содержать дополнительные элементы, которые следует выбрать
при передаче видео с того или иного устройства.

Установки рендеринга (рис. 4.8) определяют алгоритм расчета содержимого фильма
по программе действий пользователя, записанных в окне Timeline (Монтаж). Напомним,
что рендерингом (rendering) называется процесс построения изображения каждого кадра по
его описанию, которое пользователь создает в процессе монтажа фильма. Рендеринг произ-
водится для предварительного просмотра рабочей области фильма или при его экспорте (в
последнем случае вместо установок проекта применяются задаваемые отдельно установки
экспорта). Предварительный просмотр выполняется либо при нажатиии клавиши <Enter>,
либо при выборе команды Sequence> Render Work Area (Фильм>Рендеринг рабочей обла-
сти).
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Рис. 4.7. Установки оцифровки

Раскрывающийся список Compressor (Компрессор) – выбирает кодек, который будет
использоваться для сжатия изображения и звука. Выбирайте те кодеки, которые, с одной
стороны, обеспечат хорошее качество изображения, а с другой – скорость расчетов и прием-
лемый физический размер видеофайла (если это имеет для вас значение). Если выбрать эле-
мент None (Нет), то сжатия видео производиться не будет, соответственно качество фильма
при экспорте не ухудшится, однако файл, в результате, получится очень большим.

Примечание
У вас есть возможность инсталлировать дополнительные кодеки,

которые будут распознаны Premiere. В частности, если на вашем компьютере
установлено устройство оцифровки, компрессия может производиться
аппаратным способом (т. е. не при помощи процессора компьютера, а самого
устройства). В этом случае время, затрачиваемое на создание фильма, может
существенно сократиться.
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Рис. 4.8. Установки рендеринга

Надо отметить, что в новой версии Premiere большинство параметров, определяющих
рендеринг, устанавливается непосредственно в собственных окнах подключаемых модулей
кодеков. Наборы этих установок существенно зависят от конкретного кодека и, соответ-
ственно, в разных случаях дают пользователю различную свободу действий по управлению
рендерингом фильма. В качестве примера на рис. 4.9 и рис. 4.10 приведены окна настроек
двух разных кодеков.

При работе с кодеками важно упомянуть о такой важной детали, как ключевые кадры
рендеринга (rendering keyframe). Ключевым называется кадр, который записывается в видео-
файл без сжатия, т. е. без ухудшения изображения. Последующие кадры сохраняются в
видеофайле путем фиксации изменений, произошедших в них относительно ключевого
кадра. Таким образом, чем реже расположены ключевые кадры, тем более сильного сжа-
тия очень часто можно достичь. Имейте в виду, что не все кодеки используют технологию
сжатия с использованием ключевых кадров, однако большинство из них позволяют задать
частоту ключевых кадров. В частности, настройку данной опции предусматривают популяр-
ные кодеки MPEG-4, DivX;) и DivX, чаще всего использующиеся для сжатия кинофильмов
(рис. 4.10).
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Рис. 4.9. Установки кодека Cinepack

Рис. 4.10. Установки кодека DivX

Раскрывающийся список Color Depth (Глубина цвета) – определяет число цветов,
которые могут использоваться для представления пиксела изображения. Чем больше глу-
бина пиксела, тем качественнее картинка, но тем больше ресурсов компьютера требуется
(в частности, тем большим получается файл предварительного просмотра). Но некоторые
кодеки не позволяют регулировать глубину пиксела, используя всегда определенное коли-
чество цветов в палитре (например, 256 цветов, или 8-битовую глубину цвета, как кодек
Microsoft RLE).

Флажок Optimize Stills (Оптимизировать статические кадры) – позволяет существенно
сэкономить ресурсы компьютера при рендеринге статических изображений. Если флажок
выставлен, то вместо создания последовательности идентичных кадров будет создан един-
ственный кадр определенной длительности.
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Внимание
Некоторые устройства оцифровки не поддерживают режим

оптимизации статических кадров. Если вы используете такие устройства при
работе с Premiere – сбросьте данный флажок.

 
4.2.6. Установки фильма по умолчанию

 
Установки на странице Default Sequence (Фильм по умолчанию) определяют, в каком

виде будут открываться вновь создаваемые фильмы в окне Timeline (Монтаж), а именно,
какое количество видео – и аудиотреков будет создано изначально. Имейте в виду, что впо-
следствии при работе с проектом число доступных треков можно изменить как в большую,
так и в меньшую сторону.

Установки фильма по умолчанию включают следующие поля ввода (рис. 4.11):
□ Video (Видео) – начальное число видеотреков;
□ Mono (Моно) – начальное число монофонических (одноканальных) аудиотреков;
□ Stereo (Стерео) – начальное число стереофонических (двухканальных) аудиотреков;
□ 5.1 – начальное число многоканальных аудиотреков, 6-канальный звук (3 фронталь-

ных канала + 2 тыловых + 1 низкочастотный).
Три последних установки присутствуют на странице Default Sequence (Фильм по

умолчанию) в двойном экземпляре – для рабочих аудиотреков и треков субмикширования (с
этими типами звуковых треков вы познакомитесь на уроке II). Таким образом, число аудио-
треков определяется независимо для этих двух типов треков.

Примечание
Как вы видите, начиная с новой версии Premiere Pro,

аудиотреки подразделяются на три типа согласно формату аудиозаписей.
Соответственно, клипы с монофоническим звуком могут располагаться
только на монофонических аудиотреках и т. д.
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Рис. 4.11. Установки фильма по умолчанию
 

4.2.7. Изменение установок проекта
 

Поменять некоторые установки можно и после создания нового проекта, уже при
работе над ним. Изменение установок в процессе монтажа производится с помощью диало-
гового окна Project Settings (Установки проекта), которое является близнецом диалогового
окна New Project (Создание проекта) (рис. 4.12). Это окно также имеет четыре страницы,
содержание которых было рассмотрено нами выше. Каждая из страниц позволяет задать
определенный тип установок. Переход от страницы к странице осуществляется при помощи
списка в левой части окна.
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Рис. 4.12. Диалоговое окно Project Settings позволяет отредактировать некоторые
установки в процессе монтажа

Для того чтобы просмотреть и отредактировать установки проекта, выполните следу-
ющие действия:

1. Вызовите диалоговое окно Project Settings (Установки проекта) при помощи
команды меню Project>Project Settings (Проект>Установки проекта) и выбора в подменю
нужного типа установок, например – General (Общие).

2. Просмотрите и измените доступные установки проекта.
3. Если вы хотите поменять несколько установок, перейдите к нужному типу при

помощи левого списка в диалоговом окне Project Settings (Установки проекта).
4. Подтвердите изменение установок нажатием кнопки ОК.

Внимание
В новой версии программы Premiere Pro лишь немногие из установок

можно поменять в процессе работы над проектом. Большинство элементов
управления, задающих важнейшие установки проекта, недоступны в
диалоговом окне Project Settings (Установки проекта). Если вам все – таки
очень хочется поменять некоторые из них, то ничего не остается, кроме
закрытия данного проекта и создания нового, с желаемыми установками.
Затем в новый проект следует импортировать предыдущий проект, и
работать уже с ним. В этом случае все равно следует быть очень
внимательным, т. к. различие в установках проектов иногда может приводить
к плохо прогнозируемым дефектам изображения на некоторых кадрах
фильма. Помните также о том, что установки проекта никак не влияют на
атрибуты файла, в который вы экспортируете смонтированный фильм. Для
него применяются другие установки (экспорта), которые можно свободно
изменять, независимо от того, какие установки вы выбрали для проекта (см.
разд. 4.3).
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4.2.8. Сохранение предустановок пользователя

 
Если вы работаете с Premiere, то, вероятнее всего, будете создавать не один проект с

похожими установками. Наборы этих установок могут отличаться от предустановок, имею-
щихся в Premiere. Поэтому для удобства можно сохранить характерный для вашей работы
набор параметров проекта в качестве новой предустановки с тем, чтобы в следующих про-
ектах не определять все настройки вручную, а сразу загрузить их как предустановку поль-
зователя.

Рис. 4.13. Определение имени новой предустановки

Для сохранения предустановки следует выполнить несколько простых шагов:
1. В диалоговом окне New Project (Создание проекта) на закладке Custom Settings

(Настройка установок), если вы находитесь в режиме создания нового проекта, или в окне
Project Settings (Установки проекта), если вы редактируете ранее созданный проект, откор-
ректируйте все установки.

2. Нажмите кнопку Save (Сохранить).
3. В открывшемся диалоговом окне Save Project Settings (Сохранить установки про-

екта) (рис. 4.13) введите имя новой установки в поле Name (Название) и, по желанию, ее
краткое описание в поле Description (Описание).

4. Нажмите кнопку ОК.
После сохранения предустановки при создании нового проекта она станет доступной

в диалоговом окне New Project (Создание проекта). Всякий раз при попытке загрузить уста-
новки проекта в списке предустановок в группе Custom (Установки пользователя) будет при-
сутствовать и предустановка пользователя (рис. 4.14).
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Рис. 4.14. Предустановка пользователя в окне New Project
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4.3. Установки экспорта

 
В предыдущем разделе были подробно разобраны установки, которые используются

для расчета и отображения кадра в окне Monitor (Монитор) в процессе редактирования
фильма. После завершения монтажа вы экспортируете фильм во внешний файл, причем в
этом случае установки экспорта могут быть совершенно иными, нежели установки проекта.

Рассмотрим, как можно выбрать установки экспорта.
1. Выделите фильм, который вы собираетесь экспортировать, в окне Project (Проект)

или Timeline (Монтаж).
2. Введите команду File>Export>Movie (Файл>Экспорт>Фильм).
3. В открывшемся диалоговом окне Export Movie (Экспорт фильма) нажмите кнопку

Settings (Установки). Перед этим обратите внимание на то, что текущие установки экспорта
перечислены в списке Summary (Описание) в нижней части окна (рис. 4.15).

Рис. 4.15. Установки экспорта указаны в списке Summary

4. Просмотрите и отредактируйте соответствующие установки в открывшемся диало-
говом окне Export Movie Settings (Установки экспорта фильма) (рис. 4.16). Это диалоговое
окно имеет структуру, похожую на окно New Project (Создание проекта); таким образом,
следует просмотреть и откорректировать установки на четырех страницах.

5. По завершении редактирования установок нажмите кнопку ОК.
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6. В окне Export Movie (Экспорт фильма) задайте имя файла и нажмите кнопку Save
(Сохранить), чтобы начать экспорт фильма.

Рис. 4.16. Определение установок экспорта производится в окне Export Movie Settings

Установки экспорта несколько отличаются от рассмотренных нами выше установок
проекта, хотя большинство из них по смыслу эквивалентно установкам проекта, с той
поправкой, что относятся они исключительно к файлу, в который экспортируется фильм.
Установки экспорта будут подробно рассмотрены на уроке 15 (см. разд. 15.2).

Комбинацию установок экспорта, подобно установкам проекта (см. разд. 4.2.8), можно
сохранить для последующего использования при экспорте других фильмов.

Для сохранения предустановки экспорта выполните следующие действия:
1. Вызовите описанным выше способом диалог Export Movie Settings (Установки экс-

порта фильма).
2. Просмотрите и откорректируйте все установки экспорта.
3. Нажмите кнопку Save (Сохранить).
4. В открывшемся диалоговом окне Save Export Settings (Сохранить установки экс-

порта) введите имя новой предустановки в поле Name (Название) и, по желанию, ее краткое
описание в поле Description (Описание) (рис. 4.17).

5. Нажмите кнопку ОК.
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Рис. 4.17. Сохранение установок экспорта пользователя

После этого комбинацию установок экспорта можно использовать снова и снова. Стоит
заметить, что применение предустановок экспорта несколько отличается от предустановок
проекта, поскольку их сохранение производится не в служебных файлах Premiere, а во внеш-
нем файле с расширением prexport.

Для использования сохраненной ранее предустановки экспорта выполните следую-
щее:

1. Вызовите диалоговое окно Export Movie Settings (Установки экспорта фильма) и
нажмите в нем кнопку Load (Загрузить).

2. В открывшемся диалоговом окне Load Export Settings (Загрузить установки экс-
порта) выберите файл с сохраненными установками экспорта (с расширением prexport) и
нажмите кнопку Open (Открыть) (рис. 4.18).

3. Для осуществления экспорта фильма действуйте далее стандартным способом.
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Рис. 4.18. Загрузка установок экспорта, сохраненных ранее во внешний файл

Таким образом, файлы с сохраненными установками экспорта можно использовать при
работе на других компьютерах (достаточно просто перенести их туда вместе с прочими фай-
лами проекта).
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Урок 5

Проекты
 

Этот урок посвящен описанию средств Premiere по управлению проектами. Большую
часть главы занимает рассмотрение возможностей и настроек окна Project (Проект). В
последнем разделе приводятся сведения о работе с файлами проектов.

В принципе, если вы создаете простые фильмы, и действия в окне Project (Проект)
имеют для вас второстепенное значение, но, в то же время, вы на интуитивном уровне
неплохо обращаетесь с типовыми приложениями ОС Windows, то можете пропустить этот
урок. Обращаться к его разделам вы сможете и впоследствии, сталкиваясь в вашей дальней-
шей работе с необходимостью тех или иных манипуляций с проектами.

□ Чего мы хотим:
• научиться обращаться с окном Project (Проект).
□ Нам потребуется:
• любой проект, содержащий несколько клипов различного типа.
□ Что полезно вспомнить:
• как устроен интерфейс Premiere (см. урок 2).
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5.1. Окно Project

 
Окно Project (Проект) – одно из основных окон Premiere, и оно всегда активно при

создании нового или открытии ранее сохраненного проекта. Окно Project (Проект) явля-
ется одновременно и хранилищем исходных клипов, которые вы помещаете туда с жесткого
диска вашего компьютера или внешнего устройства, подключенного к компьютеру, и пере-
датчиком клипов в окнах Monitor (Монитор) и Timeline (Монтаж) для компоновки их в
фильмы. Фактически окно Project (Проект) представляет собой библиотеку клипов и филь-
мов, и одной из его главных задач является обеспечение быстрого поиска нужного клипа
или фильма.

Рис. 5.1. Окно Project при загрузке нового проекта содержит только пустой фильм,
добавленный в него по умолчанию

Если вы начинаете новый проект, то сначала Premiere попросит вас определить его
имя и расположение файла проекта на диске. Название проекта затем будет отображаться на
закладке окна Project (Проект) (рис. 5.1). При создании нового проекта он не будет содер-
жать ни одного клипа. Если вы открываете сохраненный проект, то окно Project (Проект)
будет содержать клипы, ранее помещенные в этот проект, и иметь соответственно название,
присвоенное вами проекту (рис. 5.2).

Примечание
Напомним, что создать новый проект можно командой

FIIe>New>Project (Файл> Создать>Проект), а открыть существующий
– при помощи команд FIIe>Open Project (Файл>Открыть проект) или
FIIe>Open Recent Project (Файл>Открыть недавний проект).

Рассмотрим последовательно области и панель инструментов окна Project (Проект).
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5.1.1. Область предварительного просмотра

 
Под заголовком и закладкой окна Project (Проект) находится область предваритель-

ного просмотра (preview area) (рис. 5.1, 5.2). Она служит для просмотра в миниатюре и
прослушивания клипов, помещенных в окно Project (Проект), а также для отображения их
основных свойств. С помощью этой области можно быстро ознакомиться с содержимым
клипа и выбрать из окна Project (Проект) нужный клип для последующего его монтажа в
фильм. В области предварительного просмотра всегда отображается кадр и свойства клипа,
выделенного в окне Project (Проект).

Рис. 5.2. Окно Project после загрузки ранее сохраненного проекта содержит клипы,
импортированные в прошлых сессиях работы

Слева в области предварительного просмотра находится миниатюра с кадром клипа.
С помощью кнопки запуска/останова воспроизведения, расположенной слева от нее, можно
просматривать клип. Элементы управления воспроизведением области предварительного
просмотра окна Project (Проект) похожи на кнопки окна Monitor (Монитор) и имеют тот
же смысл.

Перечислим их:
□ Play/Stop (Проиграть/Остановить) – кнопка запуска и останова воспроизведения

клипа в миниатюре;
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□ полоса прокрутки – служит для покадрового просмотра клипа;
□ Set Poster Frame (Сделать фоновым кадром) – кнопка, которая устанавливает теку-

щий кадр в области предварительного просмотра в качестве так называемого фонового кадра
(poster frame).

Примечание
Фоновый кадр является «визитной карточкой» клипа. В частности,

пиктограмма с ним сопровождает клип в списке клипов в окне Project
(Проект), если включен соответствующий режим.

Правая часть области предварительного просмотра содержит информацию о свойствах
выделенного клипа или фильма. Поменять свойства клипа при работе над ним в Premiere, в
отличие от установок проекта или экспорта, вы уже не сможете. Эта информация полезна для
сравнения установок клипов, которые вы собираетесь монтировать в окне Timeline (Мон-
таж). Рекомендуется, чтобы установки исходных клипов, по возможности, совпадали друг
с другом, а также с установками фильма.

Рис. 5.3. Скрытие области предварительного просмотра производится при помощи
меню окна Project

Для того чтобы увидеть информацию о клипе или фильме из окна Project (Проект),
вам достаточно выделить его щелчком в области клипов. Кадр клипа загрузится в миниа-
тюру области предварительного просмотра. С помощью кнопки Play (Проиграть) и шкалы
с ползунком вы просматриваете или прослушиваете клип в зависимости от его типа. Если
вы выделили в области клипов статический клип, то кнопки воспроизведения будут недо-
ступны, т. к. такой клип не меняется во времени, и вы сможете просто наблюдать само стати-
ческое изображение клипа. Если ни один из клипов не выделен, то область предварительного
просмотра пуста. Если выделено несколько элементов, то соответствующая информация (об
их количестве) будет приведена в области предварительного просмотра.

Область предварительного просмотра может быть временно скрыта из окна Project
(Проект) в целях увеличения основной области клипов и фильмов. Для этого достаточно вос-
пользоваться командой View>Preview Area (Вид> Область предварительного просмотра)
меню окна Project (Проект) (рис. 5.3).
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5.1.2. Список клипов и фильмов

 
Основную часть окна Project (Проект) под областью предварительного просмотра,

занимает список клипов, импортированных в проект, и фильмов, которые в нем редактиру-
ются.

Рис. 5.4. Область клипов в виде значков

Организация списка клипов и фильмов очень похожа на организацию папок с файлами
в ОС Windows и может иметь один из двух видов, выбираемых пользователем.

□ List View (Список) – клипы представлены в виде таблицы (см. рис. 5.2, 5.3). Первый
столбец содержит пиктограммы (либо миниатюры), говорящие о типе медиа (видео, аудио,
статическое изображение или фильм). Второй столбец состоит из имен клипов, третий – цве-
товые метки, присвоенные данному элементу согласно его типу медиа, далее идут столбцы
с длительностью, свойствами видео – и аудиосоставляющих клипов, комментариями и т. п.
Количество и порядок следования столбцов могут быть настроены пользователем.

□ Icon View (Значок) – клипы представлены в виде миниатюр – фоновых кадров с
именем и длительностью (рис. 5.4).



Е.  Н.  Кирьянова, Д.  В.  Кирьянов.  «Самоучитель Adobe Premiere Pro»

95

Переключить режимы представления списка можно при помощи пары кнопок, нахо-
дящихся слева на панели инструментов окна Project (Проект) (рис. 5.4). Более подробная
информация о настройке окна Project (Проект) приведена в разд. 5.2.

 
5.1.3. Панель инструментов окна Project

 
Панель инструментов окна Project (Проект) примыкает к его нижней границе (рис. 5.5)

и служит для быстрого ввода той или иной команды.

Рис. 5.5. Панель инструментов окна Project

Перечислим слева направо названия кнопок панели инструментов, а подробно расска-
жем об их действии в следующих разделах:

□ List (Список) – переводит область клипов в вид списка;
□ Icon (Значок) – переводит область клипов в вид значков;
□ Automate to Sequence (Автоматически вставить в фильм) – вставляет последова-

тельность выделенных клипов в фильм, т. е. переносит их в окно Timeline (Монтаж) один
за другим;

□ Find (Поиск) – осуществляет поиск клипов или корзин в окне Project (Проект) по
их названию или его части;

□ Bin (Корзина) – создает новую папку (корзину) для более удобной организации кли-
пов и фильмов. Не путайте с привычной «корзиной для мусора» из ОС Windows;

□ New Item (Создать элемент) – создает новые фильмы и специальные клипы как в
окне Project (Проект), так и в отдельном окне, например – титры или цветовой фон. Эта
кнопка эквивалентна действию пункта меню File>New (Файл>Создать);

□ Clear (Удалить) – удаляет выделенные в окне Project (Проект) элементы – клипы,
фильмы или корзины.
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Рис. 5.6. Меню окна Project

Перечисленные команды можно ввести как при помощи панели инструментов, так и
меню окна Project (Проект) (рис. 5.6). Кроме того, меню окна позволяет производить неко-
торые дополнительные операции.
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5.2. Настройка окна Project

 
Внешний вид окна Project (Проект) может быть настроен в соответствии с вашими

потребностями.
Во – первых, допускается скрытие области предварительного просмотра из окна

Project (Проект) (см. рис. 5.3). Во – вторых, можно управлять представлением области кли-
пов в каждом из его двух видов.

Пользователям предыдущих версий Premiere
В новой версии Premiere Pro интерфейс окна Project (Проект) стал

более понятным и интуитивным. Разработчики освободили его от таких
неуклюжих деталей, как область корзин и дополнительных настроек, сильно
отягощавших предыдущие версии Premiere. В то же время основные
приемы работы в окне Project (Проект) остались практически неизменными,
за исключением того факта, что в Premiere Pro (благодаря поддержке
многозадачности) оно содержит, помимо клипов, еще и фильмы.

 
5.2.1. Миниатюры клипов

 
Как уже отмечалось, область клипов может представляться в одном из двух возмож-

ных видов (см. рис. 5.2, 5.4). Эти разные виды окна Project (Проект) построены с учетом
того, какие действия собирается в нем осуществлять пользователь и, соответственно, какая
информация для него важна в тех или иных ситуациях. Переключение между различными
видами области клипов производится либо с помощью кнопок панели инструментов окна
Project (Проект) (см. рис. 5.4), либо через меню окна (см. рис. 5.6).

Меню окна Project (Проект) позволяет настроить дополнительные опции отображе-
ния элементов в окне Project (Проект), а именно – использование миниатюр для упрощения
работы с клипами. По умолчанию рядом с названием клипов отображаются пиктограммы,
говорящие о типе медиа (видео или аудио, клип или фильм). В виде значков окно Project
(Проект) по умолчанию включает миниатюры клипов среднего размера. Настроить опцию
отображения миниатюр, как для вида списка, так и для вида значков, можно при помощи
меню окна Project (Проект). Делается это так:

1. Вызовите диалоговое меню окна Project (Проект) и наведите в нем указатель мыши
на пункт Thumbnails (Миниатюры).

2. Для включения опции отображения миниатюр снимите в появившемся подменю
флажок с пункта Off (Выключено) (рис. 5.7).

3. Для задания размера миниатюр выберите в подменю Thumbnails (Миниатюры)
меню окна желаемый тип: Small (Мелкие), Medium (Средние) или Large (Крупные).
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Рис. 5.7. Настроить вид миниатюр клипов можно при помощи меню окна Project
Примечание 1
Если выбран режим Off (Выключено), подменю Thumbnails

(Миниатюры) определяет размер пиктограмм, символизирующих тип
клипов.

Примечание 2
В качестве миниатюры клипа используется один из его кадров,

называемый фоновым (poster frame). По умолчанию в качестве фонового
используется стартовый кадр клипа, но, при желании, фоновым можно
сделать любой кадр. Для этого надо отыскать данный кадр на миниатюре
предварительного просмотра окна Project (Проект) и нажать кнопку Set
Poster Frame (Сделать фоновым кадром) слева от нее.

 
5.2.2. Вид списка окна Project

 
Окно Project (Проект) в виде списка представлено таблицей с большим количеством

столбцов (рис. 5.8).
Совет
Если вам хочется видеть в окне Project (Проект) максимальное

количество разнообразной информации о свойствах клипов, выбирайте вид
списка.
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Рис. 5.8. В виде списка окно Project дает максимальную информацию о свойствах кли-
пов

В столбцах отображается следующая информация:
□ Name (Название) – имя исходного клипа или фильма, причем имеется возможность

менять это имя прямо в окне Project (Проект), щелкая на нем и вводя другое;
□ Label (Метка) – цвет, сопоставленный данному элементу;
□ Media Туре (Медиа – тип) – тип медиа, например – Sequence (Фильм), Movie

(Видео), Audio (Аудио) или Still Image (Статическое изображение);
□ Media Start (Старт) – тайм – код начала клипа;
□ Media End (Конец) – тайм – код конца клипа;
□ Media Duration (Длительность) – общая длительность (видео и аудио) клипа, пред-

ставленная в формате временной базы;
□ Video In Point (Точка входа видео) – номер кадра, идентифицирующий начало (вход-

ной маркер) видеосоставляющей клипа в области Source (Источник) окна Monitor (Мони-
тор);
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